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Data Acquisition and Processing Report

NOAA Ship Thomas Jefferson
Chief of Party: Christiaan Van Westendorp, NOAA

Year: 2016
Version: 1

Publish Date: 2017-02-21

A Equipment

A.1 Survey Vessels

A.1.1 NOAA Ship Thomas Jefferson (WTEA)

Name NOAA Ship Thomas Jefferson (WTEA)
Hull Number S-222

Description NOAA Ship Thomas Jefferson is a steel hulled hydrographic survey ship built by
 Halter Marine, Inc, Moss Point, MS. 

Utilization
The primary mission of “NOAA Ship Thomas Jefferson” is to acquire hydrographic
 survey data to update NOAA nautical charts. Based on current draft and sonar
 configuration, the ship can operate in waters between 30 feet and 8200 feet deep.

Dimensions
LOA 208 feet
Beam 45 feet
Max Draft 17 feet

Most Recent Full
Static Survey

Date 2016-09-01
Performed By The IMTEC Group, Ltd.

Discussion

A full static survey was completed during
the 2016 extended drydock of Thomas
Jefferson. This was in conjunction
with the installation of the Kongsberg
EM710 and EM2040 MBES. The survey
measured the following points: IMU,
ORU, EM710 Transmitter and Receiver,
EM2040 Transmitter and Recevier,
Bubbler Orifice, Odom Echotrac Mk III
transducer, Knudsen 320B Transducer,
Port and Starboard POS MV GPS
Antennae. The survey report is included
as an appendix to this document.
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Most Recent Partial
Static Survey Partial static survey was not performed.

Most Recent Full
Offset Verification Full offset verification was not performed.

Most Recent Partial
Offset Verification Partial offset verification was not performed.

Most Recent Static
Draft Determination

Date 2016-10-13
Method Used Bubbler and Ellipsoid

Discussion

Static draft was performed by use of a
Sutron bubbler gauge installed on the
ship. An ellipsoidally-referenced static
draft was also performed to confirm these
values.

Most Recent
Dynamic Draft
Determination

Date 2016-10-13
Method Used Ellipsoidally Referenced Dynamic Draft

Discussion

Dynamic draft was determined using
the Ellipsoidally Referenced Dynamic
Draft Model (ERDDM). Acquisition and
processing was done in accordance with
FPM Section 1.4.2.1.2.1 via the Pydro
macro ProcSBETDynamicDraft.py.
Ellipsoid heights were obtained via the
5P method, described in Section B.2.4.
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Figure 1: NOAA Ship Thomas Jefferson (WTEA)
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A.2 Echo Sounding Equipment

A.2.1 Side Scan Sonars

A.2.1.1 Klein 5000 V2

Manufacturer Klein
Model 5000 V2

Description

The Klein High Speed, High Resolution Multi-Beam Side Scan Sonar (SSS) system is
 a beam-forming acoustic imagery device. The integrated system includes a Klein 5000
 towfish, a Transceiver/Processing Unit (TPU), and a computer for user interface. Stern-
towed units also include a tow cable telemetry assembly. The towfish operates at a frequency
 of 455kHz and a vertical beam angle of 40°, and can resolve up to 5 discrete received beams
 per transducer stave. The system is capable of ranges up to 250 meters, however “Thomas
 Jefferson” does not use the 150m or the 250m reconnaissance mode. In addition, the Klein
 5000 V2 model can collect bathymetric information using phase differencing. Each side
 scan transducer stave contains 3 bathymetry staves. The bathymetry staves operate at
 455kHz, with an along track resolution of 0.4°, and can resolve one discrete beam per side.
 “Thomas Jefferson” operates the Klein 5000 as a stern-towed unit, and does not process or
 use the collected bathymetric data.

Positioning of the Towfish is calculated using Caris SIPS, and is derived from the amount
 of cable out, the towfish depth (from the towfish pressure gauge), the vessel's Course Made
 Good (CMG), and the vessel's heading. Towfish altitude is maintained between 8% and
 20% of the range scale unless specifically noted in the Descriptive Report. Vessel speed is
 adjusted during SSS acquisition to ensure that object detection density is met. Confidence
 checks are performed by noting changes in linear bottom features extending to the outer
 edges of the digital side scan image, and by verifying aids to navigation or other known
 features on the side scan record. 

Serial
Numbers

Vessel Installed
On

"Thomas Jefferson"

TPU s/n 778

Towfish s/n 385
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Specifications

Frequency 455 kilohertz

Along Track
Resolution

Resolution 10  centimeters 20  centimeters 36  centimeters

Min Range 0 meters 39 meters 76 meters

Max Range 38 meters 75 meters 150 meters

Across Track
Resolution 3.75 centimeters

Max Range
Scale 150 meters

Manufacturer
Calibrations Manufacturer calibration was not performed.

Figure 2: Klein 5000 V2

A.2.2 Multibeam Echosounders
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A.2.2.1 Kongsberg EM2040

Manufacturer Kongsberg
Model EM2040

Description

The Kongsberg EM2040 MBES is a high resolution shallow water MBES.  It is
 capable of operating at 200, 300, and 400 kHz.  Across-track swath width is up
 to 5.5 times water depth.  Per HSTB recommendations, TJ operates the 2040 in a
 restricted fashion; namely, a 90 degree swath width and in Single Center Sector
 mode. 

Serial Numbers

Vessel Installed On S222

Processor s/n CZC3410L1L

Transceiver s/n 40072

Transducer s/n 0

Receiver s/n 334

Projector 1 s/n 236

Projector 2 s/n None

Specifications

Frequency 300 kilohertz

Along Track 0.7 degrees
Beamwidth

Across Track 0.7 degrees

Max Ping Rate 50 hertz

Beam Spacing
Mode Equidistant 

Beam Spacing
Number of
Beams 200

Max Swath Width 140 degrees

Depth Resolution 26 millimeters

Manufacturer
Specified 635 meters 

Depth Rating
Ship Usage 600 meters

Manufacturer
Calibrations

Vessel Installed On
A Sea Acceptance Testing (SAT) cruise was conducted prior to starting
this project. Personnel from HSTB, CSDL, Kongsberg USA, and UNH's
CCOM were involved with the testing. A full report is attached.

Calibration Date 2016-10-01
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System Accuracy
Tests

Vessel Installed On "Thomas Jefferson" "Thomas Jefferson"

Methods

An accuracy test was conducted on
DN321 (November 16th) by means
of a reference surface run by the
ship using the EM2040, and 3101
using a Reson 7125 SV2 MBES.

A self-reference test was conducted
on DN293 by HSTB personnel as
part of acceptance testing.

Results

The resultant values, created by
differencing two CUBE surfaces
generated by the two datasets,
showed a mean difference of
0.016m and a standard deviation
value of 0.064m. Additional
accuracy

The 300kHz mode showed a mean
bias at nadir of 0.1% of water depth
(in the 75m depth in which the
testing was performed, this came out
to 0.08m).

Snippets Sonar does not have snippets logging capability.

A.2.3 Single Beam Echosounders

No single beam echosounders were utilized for data acquisition.

A.2.4 Phase Measuring Bathymetric Sonars

No phase measuring bathymetric sonars were utilized for data acquisition.

A.2.5 Other Echosounders

No additional echosounders were utilized for data acquisition.

Additional Discussion

The Klein 5000 V2 is a Phase Measuring Bathymetric Sonar, but it is not used in that capacity so it is
 documented above as a SSS, which is how it is used aboard "Thomas Jefferson."
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A.3 Manual Sounding Equipment

A.3.1 Diver Depth Gauges

No diver depth gauges were utilized for data acquisition.

A.3.2 Lead Lines

Manufacturer Ship's Force
Model n/a

Description
The lead lines aboard “Thomas Jefferson” are standard lead lines, constructed and
 calibrated in accordance with Appendix 1 of NOAA's Field Procedures Manual
 (2013 ed). 

Serial Numbers
TJ A 16m

TJ S222 23m

TJ 07 2012

Calibrations

Serial Number TJ A 16m TJ S222 23m TJ 07 2012

Date 2015-04-15 2015-04-15 2015-04-15

Procedures
The lead line was
calibrated against a
steel measuring tape.

The lead line was
calibrated against a
steel measuring tape.

The lead line was
calibrated against a
steel measuring tape.

Accuracy Checks No accuracy checks were performed.
Correctors None of the lead lines required correctors.
Non-Standard
Procedures Non-standard procedures were not utilized.
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Figure 3: Lead line used aboard Thomas Jefferson and her survey launches

A.3.3 Sounding Poles

Manufacturer Ship's Force
Model n/a

Description
“Thomas Jefferson” has two non-traditional sounding poles. Both poles are round
 steel with a plastic covering, capped by a weighted metal shoe. Each pole is 4 meters
 in length, with graduations at 0.25m. 

Serial Numbers
TJ-SP-1

TJ-SP-2
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Calibrations

Serial Number TJ-SP-1 TJ-SP-2

Date 2015-04-29 2015-04-29

Procedures
The sounding pole was calibrated
using a steel tape.

The sounding pole was calibrated
using a steel tape.

Accuracy Checks No accuracy checks were performed.
Correctors No correctors were required.
Non-Standard
Procedures Non-standard procedures were not utilized.
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Figure 4: Sounding pole used aboard Thomas Jefferson and her survey launches.
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A.3.4 Other Manual Sounding Equipment

No additional manual sounding equipment was utilized for data acquisition.

A.4 Positioning and Attitude Equipment

A.4.1 Applanix POS/MV

Manufacturer Applanix (a Trimble company)
Model 320 v.4 & 320 v.5

Description

“Thomas Jefferson” is equipped with an Applanix POS MV 320 Position and
 Orientation Sensor version 5 to measure and calculate position and attitude. The
 POS MV is a GPS-aided inertial navigation system, which provides a blended
 position solution derived from both an Inertial Motion Unit (IMU) and an integrated
 GPS receiver. The IMU and GPS receiver are complementary sensors, and data from
 one are used to filter and constrain errors from the other. 

Position accuracy is displayed in real time by the POS MV software and was
 monitored to ensure that positioning accuracy requirements as outlined in the NOS
 Hydrographic Surveys Specifications and Deliverables (HSSD) were not exceeded.
 In addition, the POS MV software displays HDOP and the number of satellites used
 in position computation. Data acquisition was generally halted when an HDOP of
 2.5 was exceeded or the number of satellites available dropped below four.

However, because positional accuracy can be maintained by the POS/MV through
 short GPS outages with the help of the IMU, data acquisition was not halted during
 short periods of time when the HDOP and number of satellites used exceeded stated
 parameters. It has yet to be identified if this practice needs to be modified when
 using the MarineStar service or what the new operational constraints may be.

In addition to position, the Applanix POS MV also provides accurate navigation and
 attitude data to correct for the effects of heave, pitch, roll and heading. The POS MV
 generates attitude data in three axes (roll, pitch and heading) to an accuracy of 0.02°
 or better. Heave measurements supplied by the POS MV maintain an accuracy of
 5% of the measured vertical displacement for movements that have a period of up to
 20 seconds. The Heave Bandwidth filter was configured with a damping coefficient
 of 0.707. The cutoff period of the high pass filter was determined by estimating
 the swell period encountered on the survey grounds. These values ranged from 8
 seconds (flat water) to 20 seconds (long period ocean swell), with values of 8 or 12
 seconds typically. Currently the ship system is set to 9 seconds and the launches are
 set to 8 seconds. Intermittent problems with the heading accuracy climbing above
 the ideal cutoff of 0.05° are observed. Heading accuracy is monitored by the launch



2016 DAPR Version 1           NOAA Ship Thomas Jefferson         

13

 crew and survey operations are temporarily suspended in the event that the error
 exceeds 0.08°. Applanix “TrueHeave” values are also recorded. The TrueHeave
 algorithm uses a delayed filtering technique to eliminate many of the artifacts
 present in real time heave data. The TrueHeave data were applied to Kongsberg
 bathymetry in Caris HIPS post processing. Full POSPac data are also recorded on
 “Thomas Jefferson” and both of her survey launches. These data are used in real-
time to correct for vessel motion.  Additionally , in the event of real-time data falling
 outside of acceptable quality bounds,  these files are post processed to produce
 superior position and attitude data in the form of a Smoothed Best Estimate of
 Trajectory (SBET) which is then applied in Caris. 

PCS

Manufacturer Applanix

Model 320 v.5

Description

The PCS blends raw acceleration measurements from the IMU, with
position information from the GPS antennas and RTCM beacon, creating
a tightly-coupled position and orientation solution. The PCS outputs a one
Pulse Per Second (PPS) signal to integrated systems to accurately time-
stamp data.

Firmware Version 8.23

Software Version 7.92

Serial Numbers

Vessel Installed
On

S222

PCS s/n 6497



2016 DAPR Version 1           NOAA Ship Thomas Jefferson         

14

IMU

Manufacturer Applanix

Model LN 200

Description

The POS MV Inertial Measurement Unit (IMU) is used to record the
amount of heave, pitch, and roll experienced by the vessel. The IMU is
located at the vessel's central reference point, and is strapped down to
the vessel. Since the IMU is fixed to the vessel, the motion experienced
by the IMU is, by definition, the same motion experienced by the vessel.
The IMU housing contains three orthogonally placed accelerometers,
which sense acceleration in the x, y, and z directions. It also contains three
orthogonally placed gyros, which sense angular rate of motion around the
three axes. The measured amount of acceleration and rate of rotation is
then used to find the degree of pitch, roll, and heave experienced by the
vessel. Data from the IMU is also combined with data from the GNSS
antennas to calculate vessel heading.

Serial Numbers

Vessel Installed
On

S222

IMU s/n 1074

Certification
IMU s/n 1074

Certification Date 2014-09-25

Antennas

Manufacturer Trimble

Model GA830

Description A high gain GNSS antenna.

Serial Numbers

Vessel Installed
On

Antenna s/n
Port or
Starboard

Primary or
Secondary

S222 7238 Port Primary

S222 7239 Starboard Secondary

GAMS Calibration
Vessel S222

Calibration Date 2015-06-16

Configuration
Reports

Vessel S222

Report Date 2016-10-13

A.4.2 DGPS
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Description

The Trimble SPS361 receiver uses RTCM DGPS corrections either broadcast free
 by IALA Beacon stations, from SBAS (Satellite Based Augmentation Systems)
 or via an external radio or Internet connection from a DGPS reference station. 
 GPS correctors are fed to the Applanix POS MV to produce real time differentially
 corrected positions. 

Antennas No DGPS antennas were installed.
Receivers No DGPS receivers were installed.

Description

Fugro Marinestar is a commercial service that provides real-time GPS correctors
 via satellite.  The correctors are derived using a Precise Point Positioning (PPP)
 approach and are based on a state estimation of the GPS system rather than a
 differential correction.  The state estimation includes real-time estimate of satellite
 orbits, clock errors, and atmospheric delays.  The specified accuracy advertised by
 MarineStar are generally less than 10cm in the horizontal and 15cm in the vertical at
 95% confidence interval. 

The Marinestar corrector signal is received on the L1 channel of the primary POS
 MV antenna and is logged directly into the POS MV PCS.  As such, no additional
 antenna or receiver equipment is necessary. 

Antennas No DGPS antennas were installed.
Receivers No DGPS receivers were installed.

A.4.3 Trimble Backpacks

Trimble backpack equipment was not utilized for data acquisition.

A.4.4 Laser Rangefinders

Manufacturer Laser Technology Inc.
Model TruPulse 360 R

Description

LTI TruPluse 360 R is a hand held laser range finder. 

The device can be operated in 5 modes: horizontal distance, vertical distance, slope
 distance and inclination (or percent slope), 3-point flexible height routine with auto
 sequencing, and 2-shot missing line routine. 

There are also 5 target modes which are standard, closest, farthest, continuous, and
 filter. 

The Measurement range is 0 to 3280ft typical and 6560ft max to reflective target,
 inclination range of +/- 90 degrees and an azimuth range 0 to 359.9 degrees. The
 range finder is accurate in distance +/- 0.30 meters to high quality targets and +/-1
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 meter to low quality targets, inclination accuracy of +/-0.25 degrees and azimuth
 accuracy of +/- 1 degree. 

Serial Numbers 000172

DQA Tests DQA test was not performed.

Figure 5: TruPulse 360 R

A.4.5 Other Positioning and Attitude Equipment
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No additional positioning and attitude equipment was utilized for data acquisition.

A.5 Sound Speed Equipment

A.5.1 Sound Speed Profiles

A.5.1.1 CTD Profilers

A.5.1.1.1 Sea-Bird Electronics SBE19

Manufacturer Sea-Bird Electronics
Model SBE19

Description

“Thomas Jefferson” uses a Sea-Bird Electronics SeaCat SBE19 Conductivity,
 Temperature, and Depth (CTD) Profiler to collect vertical sound speed profiles. The
 speed of sound is calculated from temperature, salinity, and pressure measurements.
 Temperature is measured directly. Salinity is calculated from measured electrical
 conductivity. Depth is calculated from strain gauge pressure. The system is
 configured for a sampling rate of 0.5 seconds. Depending on the depth of water, the
 profiler is either deployed by hand, or using a winch. 

Serial Numbers
Vessel Installed On S222

CTD s/n 192472-0285

Calibrations
CTD s/n 192472-0285

Date 2016-01-13

Procedures Calibrations performed by Sea-Bird Electronics
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Figure 6: Sea-Bird 19 CTD used aboard Thomas Jefferson S222
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A.5.1.2 Sound Speed Profilers

A.5.1.2.1 AML Oceanographic AML Smart/Micro SV&P Probe

Manufacturer AML Oceanographic
Model AML Smart/Micro SV&P Probe

Description

“Thomas Jefferson” uses an AML Micro SV&P Probe to collect speed of sound
 profiles via the Brooks Ocean Technology MVP. The speed of sound is measured
 directly using a 'time-of-flight' sensor. Depth is calculated via strain gauge pressure.
 The currently installed probe is the Micro SV&P, serial number 7591. 

Any changes to the installed probe will be noted in the Descriptive Report of the
 effected survey.

Calibration files are included in Appendix IV of this report. 

Serial Numbers
Vessel Installed On S222 S222 S222

Sound Speed Profiler s/n Smart SV&P 4988 Smart SV&P 5340 Smart SV&P 7591

Calibrations

Sound Speed Profiler s/n 4988 5340 7591

Date 2016-07-01 2016-06-01 2016-06-01

Procedures
Calibrations
performed by AML
Oceanographic.

Calibrations
performed by AML
Oceanographic.

Calibrations
performed by AML
Oceanographic.
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Figure 7: AML Smart SV&P Probe used in the MVP free-fall fish.

A.5.1.2.2 AML Micro CTD

Manufacturer AML
Model Micro CTD

Description

The MicroCTD is a sensor package used to measure conductivity and temperature in
 the water column while attached to a Moving Vessel Profiler towfish.  This sensor
 provides a much broader range of data than the singaround sensors traditionally
 used, and is principally used to provide temperature data for backscatter correction
 on the Kongsberg EM2040. 
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Serial Numbers
Vessel Installed On S222

Sound Speed Profiler s/n 007761

Calibrations
Sound Speed Profiler s/n 007761

Date 2016-11-04

Procedures Calibration was performed by AML

Figure 8: AML MicroCTD

A.5.2 Surface Sound Speed

A.5.2.1 Valeport MODUS SVS Thruhull

Manufacturer Valeport
Model MODUS SVS Thruhull
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Description

The Valeport MODUS SVS Thruhull is a digital time-of-flight sound speed sensor
 used to
measure the speed of sound at the transducer faces of the EM710 and EM2040.
The system has a manufacturer-stated accuracy of 0.02m/s. The sensor is fully
removable, and is deployed and recovered prior to and at the completion of
 acquisition
via a Valeport-made valve flange. 

Serial Numbers
Vessel Installed On S222

Sound Speed Sensor s/n 33711

Calibrations

Sound Speed Sensor s/n 33711

Date 2015-10-17

Procedures
Calibration was performed by Valeport, Ltd in 2014; however, the sensor
was not put into service until 2016.

Figure 9: Valeport MODUS SVS

Additional Discussion

“Thomas Jefferson” primarily uses a Brooke Ocean Moving Vessel Profiler (MVP) installed on the port
 quarter to collect sound speed profiles. The integrated system consists of a computer controlled high-speed
 winch with cable metering, a conductor cable, and a free-fall fish (FFF). Housed in the FFF is an Applied
 Microsystems SV&P Smart Sensor or a  (see above). The profiler is deployed at survey speed via the winch.
  A traditional winch on the port side can collect stationary casts with the SeaBird SBE19 or SBE19+ as a
 backup to the MVP system.  The MVP has 162m of cable on its drum as of November 2016.
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Figure 10: MVP winch aboard NOAA Ship Thomas Jefferson

A.6 Horizontal and Vertical Control Equipment

A.6.1 Horizontal Control Equipment

A.6.1.1 Base Station Equipment

No base station equipment was utilized for data acquisition.

A.6.1.2 Rover Equipment

No rover equipment was utilized for data acquisition.

Additional Discussion

The Horizontal Datum for all projects is the World Geodetic System of 1984 (WGS84). During data
 acquisition and initial processing, horizontal control for all survey data is derived from either differentially
 corrected GPS using USCG differential beacons or from the Marinestar realtime satellite corrector service.
 If DGPS is used, differential beacons are chosen based on their proximity to the survey grounds and the
 signal-to-noise ratio of the beacons if more than one beacon is near the survey grounds.

The primary means of horizontal and vertical control is the Real-Time Precise Point Positioning (RT3P)
 method, described in section B.2.4.
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As needed owing to issues with the real-time solution, horizontal and vertical control for MBES data
 is replaced in post-processing with a Smooth Best Estimate Trajectory (SBET). In the case of DGPS,
 the SBET process overwrites the position solution with an improved IAPPK solution.  In the case of
 MarineStar, SBETs are used to transform the reference frame from ITRF00 to WGS84.  A more detailed
 discussion of the processing pipeline is included in Section C.4.

A.6.2 Vertical Control Equipment

A.6.2.1 Water Level Gauges

No water level gauges were utilized for data acquisition.

A.6.2.2 Leveling Equipment

No water level gauges were utilized for data acquisition.

Additional Discussion

Vertical Datum for all projects is Mean Lower Low Water (MLLW), unless otherwise stated in the specific
 Descriptive Report. See Section C.5 for more details on the different methods used to reduce data to tidal
 datum.  "Thomas Jefferson" typically does not install additional tide gauges on projects.

The form of Vertical Control used for each survey will be listed in section C.1 of the Descriptive Report.

A.7 Computer Hardware and Software

A.7.1 Computer Hardware

Manufacturer Individual computers utilized are not discussed in this report.
Model See Additional Discussion for more information.
Description N/A 

Serial Numbers
Computer s/n Operating System Use
N/A N/A Acquisition and Processing
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A.7.2 Computer Software

Manufacturer Caris
Software Name HIPS/SIPS
Version 9.1.9
Service Pack N/A
Hotfix N/A
Installation Date 2016-12-01
Use Processing

Description

Caris HIPS (Hydrographic Information Processing System) is used for all initial
processing of multibeam echo sounder bathymetry data. The program applies vessel
offsets to the raw sonar data, corrects for tide and sound velocity, and calculates a
Total Propagated Uncertainty (TPU) for each sounding. Individual soundings are
then processed into a CUBE (Combined Uncertainty and Bathymetry Estimator)
surface. These surfaces are then reviewed in HIPS or BDB (see below) for depth
fliers, systematic errors, and agreement with adjoining and prior surveys. Caris SIPS
(Side Scan Information Processing System) is used for all processing of side scan
sonar imagery, including cable layback correction, slant range correction, contact
selection, towpoint entry, and mosaic generation.

Manufacturer Caris
Software Name BASE Editor
Version 4.2
Service Pack N/A
Hotfix N/A
Installation Date 2016-03-03
Use Processing

Description

Caris BASE Editor (FKA/AKA BDB) is used for quality control of multibeam
and vertical beam surfaces, and for management of survey features. CUBE and
Uncertainty grids are imported, and then reviewed for depth fliers and systematic
errors, and agreement with adjoining surveys. Multibeam contacts (designated
soundings), side scan sonar contacts, and detached position contacts are analyzed,
grouped, and assigned S-57 classification.

Manufacturer NOAA OCS HSTP
Software Name Pydro
Version 16.9
Service Pack r6326
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Hotfix N/A
Installation Date 2017-02-04
Use Processing

Description

HSTB Pydro is a suite of programs used to process survey data, and to generate
reports. FetchTides is used to create a .tid file from NWLON tide station data. Pydro
can be used to classify side scan sonar and multibeam bathymetry contacts and
manage survey features, however this functionality has largely been replaced by
Caris BASE Editor. Pydro is still used for the generation of chartlets, the generation
of Danger to Navigation reports, and to process TCARI tides. Velocipy is a program
used for processing sound velocity casts. This program converts the hexadecimal
SeaCat data to ASCII, and converts the ASCII data into a depth-binned sound
velocity file. MVP data is recorded in a .txt format, and can be binned via Velocipy
without conversion to ASCII. The resulting .svp files are applied to MBES and
VBES data during post processing to correct for sound velocity variation within the
water column. XmlDR is used to generate Descriptive Reports for each survey and
the Data Acquisition Processing Report for each project. QC Tools is used to assess
the quality of surfaces output by HIPS and SIPS.

Manufacturer HYPACK, Inc
Software Name Hypack 2016
Version N/A
Service Pack N/A
Hotfix N/A
Installation Date 2016-03-19
Use Acquisition

Description Hypack is used to support ship navigation via position (from the POS MV) and
autopilot interfacing.

Manufacturer Applanix
Software Name POSPac MMS
Version 7.2
Service Pack N/A
Hotfix N/A
Installation Date 2015-04-20
Use Processing

Description Applanix POSPac MMS is used to create SBETs, which provide horizontal and
vertical control to bathymetric data.

Manufacturer Applanix
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Software Name MV-POSView
Version 7.92
Service Pack N/A
Hotfix N/A
Installation Date 2015-04-08
Use Acquisition

Description

The MV-POSView controller program is used on the ship to configure and operate
the POS MV attitude and positioning system. This program is also used to record
the POS MV .000 files used to produce the SBET files applied in Caris to improve
attitude and navigation.

Manufacturer Brooke Ocean
Software Name MVP
Version 2.450
Service Pack N/A
Hotfix N/A
Installation Date 2007-02-01
Use Acquisition and Processing
Description The MVP program is used to control the MVP winch and fish.

Manufacturer QPS, Inc
Software Name Fledermaus Geocoder Tool (FMGT)
Version 7.4.0d
Service Pack N/A
Hotfix N/A
Installation Date 2015-04-10
Use Processing
Description Fledermaus Geocoder Tool (FMGT) is used to process backscatter mosaics.

Manufacturer ESRI, Inc
Software Name ArcGIS
Version 10.3
Service Pack N/A
Hotfix N/A
Installation Date 2015-04-08
Use Acquisition and Processing
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Description

ArcGIS is used for initial survey planning, such as the creation of line plans for
export into Hypack to guide the survey acquisition. ArcGIS is also used for data
analysis, where a variety of tools and a high level of customization allow for detailed
analysis of surfaces and data products.

Manufacturer Kongsberg
Software Name Seafloor Information System
Version N/A
Service Pack N/A
Hotfix N/A
Installation Date 2016-09-01
Use Acquisition

Description

Seafloor Information System (SIS) is produced by Kongsberg Maritime and is
supplied as part of the EM2040 multi-beam sonar system. This real time software
is designed to be the user interface and real time data processing system for the
EM2040. All necessary sensor interfaces, data displays for quality control and sensor
calibration, seabed visualization, data logging, and integrated seabed acoustical
imaging capability (sidescan) are standard parts of the software. Sound speed, vessel
motion, and positional data are all logged into the .all files created by the program. It
operates under the Windows operating system in a rack mounted computer dedicated
to control of the EM2040.

Additional Discussion

Computer hardware that was a core component of a sensor is listed under the Echo Sounding section,
 referred to as the "Processor" for MBES systems or the "TPU" for the SSS systems.  Computers used for
 processing of the data or controlling acquisition were completely interchangeable and the serial numbers
 used were not tracked. 

A.8 Bottom Sampling Equipment

A.8.1 Bottom Samplers

A.8.1.1 Ponar Wildco #1728
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Manufacturer Ponar Wildco
Model #1728

Description The Ponar Wildco is a winch-deployed bottom sampler used aboard “Thomas
 Jefferson.” 

Figure 11: Ponar style grab sampler used aboard NOAA Ship Thomas Jefferson.

A.8.1.2 Kahlsico Mud Snapper 214WA100

Manufacturer Kahlsico Mud Snapper
Model 214WA100

Description The Kahlsico Mud Snapper is a hand held bottom sampler that is used aboard TJ3101
 and TJ3102. 
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Figure 12: Snapper type grab sampler used aboard TJ3101 & TJ3102.

B Quality Control

B.1 Data Acquisition

B.1.1 Bathymetry

B.1.1.1 Multibeam Echosounder

All multibeam data is logged using Kongsberg Seafloor Information System (SIS) in the .all format. During
 acquisition, the hydrographer;
- Monitors the SIS interface for errors and data quality;
- Monitors the SIS interface for indication of sound speed changes requiring a cast, and conducts casts as
 necessary
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- Monitors the Hysweep interface;
- Monitors the vessel speed and requests the bridge to adjust as necessary to ensure density and coverage
 specifications are met.

B.1.1.2 Single Beam Echosounder

Single beam echosounder bathymetry was not acquired.

B.1.1.3 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar bathymetry was not acquired.

B.1.2 Imagery

B.1.2.1 Side Scan Sonar

All side scan sonar data are logged using Klein SonarPro, in the .SDF format. During acquisition the
 hydrographer:
- Monitors range, towfish height, heading, pitch, roll, latitude, longitude, speed, pressure, and temperature;
- Adjusts towfish height, in accordance with Field Procedures Manual.

B.1.2.2 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar imagery was not acquired.

B.1.3 Sound Speed

B.1.3.1 Sound Speed Profiles

“Thomas Jefferson” uses an AML Micro SV&P Probe or an AML MicroCTD installed inside an MVP
 free-fall fish to acquire sound speed profiles. Profiles aboard the ship are acquired at 30 - 90 minute
 intervals. The interval between casts is monitored real-time using NOAA's CastTime program. CastTime
 compares successive casts using a ray-tracing uncertainty analysis that estimates the effect of the sound
 speed variability towards multibeam echo sounding. When the profile comparisons show redundancy,
 meaning that the effect of the sound speed variability towards echo sounding is negligible, then this
 provides justification to relax the sampling intervals towards the 90 minute bound. Conversely, when the
 comparisons show variability with a significant effect towards echo sounding, the MVP usage is increased
 accordingly.  Additionally, the Kongsberg SIS interface provides guidance on the need for a cast (typically
 at 1-2 m/s change at the surface).   At any time, sampling intervals are adjusted as needed at the discretion
 of the surveyor, to ensure spatial variability accounted for, or if there is suspicion of sudden changes or
 anomalies in the water-column.
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TJ also uses a Sea-Bird SBE19+ CTD to collect sound speed profiles, generally at 2 - 4 hour intervals. Casts
 are also conducted when changing survey areas, or when a change of weather, tide, or current warrant. The
 launch crew also monitors the real time display of the Valeport sound velocity
probe for changes greater than 2 m/s in the surface sound velocity indicative of the need for a new cast. 

Velocipy software is used for both data processing and setting up Sea-Bird SEACAT instruments. Prior to
 deployment the SEACAT voltage is checked. The SBE 19plus should have a minimum of 9.5 volts and the
 SBE 19 should have a minimum of 7 volts. In the event of lower voltage readings, the instrument batteries
 were changed.

The site selected should be in the deepest portion of the project area expected to be surveyed.

When conducting SEACAT casts with the SBE 19, the 3-2-1 rule of thumb is followed. The instrument
 should be turned on and allowed to sit on deck for 3 minutes while the sensors settle and form baseline. The
 instrument is then set to soak just below the surface for 2 minutes. Finally the instrument is lowered at a rate
 of 1 meter/second.

When conducting SEACAT casts with the SBE 19+, the instrument should be lowered and held just below
 the water's surface for about 1 minute to allow air to escape the salinity cell. After soaking the instrument, it
 should be lowered at a rate of 1 meter/second through the water column. In areas with lenses of fresh water
 or other complex sound speed variation near the surface, the instrument should be lowered slowly (in some
 cases, much less than 1 meter/second) through the first 5-10 meters of water in order to accurately sample
 the sound speed. After this initial descent, the instrument should proceed to drop at a rate of 1 meter/second.

The Moving Vessel Profiler (MVP) is an automated winch system that deploys a fish containing a sound
 speed sensor by free fall. The fish is towed behind the survey vessel in a ready position that is marked by
 messengers attached to the tow cable. Ideally, at survey speeds the fish is “flying” just above the depth of
 the sonar transducers. The specified depth deployed is selected by specifying a distance off the bottom.
 Once at the depth limit, the winch freefall is automatically stopped and the drag forces on the fish cause it
 to rise toward the surface due to the ship's forward motion. The cable slack is then pulled in by the winch to
 the towing position.

Aboard all platforms, the hydrographer processes each cast immediately, then reviews it for erroneous data.

Figure 13: This image intentionally left blank

B.1.3.2 Surface Sound Speed

“Thomas Jefferson” uses a Valeport probe to find the speed of sound at the Kongsberg transducer face. 
 These sound speed values are applied in real-time to all MBES systems to provide refraction corrections to
 flat-faced transducers.
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The accuracy of each surface sound speed device is checked against the closest CTD data point after every
 CTD cast.

B.1.4 Horizontal and Vertical Control

B.1.4.1 Horizontal Control

Depending on Project Instructions and availability, "Thomas Jefferson" used one of the two following
 methods for horizontal control:

Marinestar Realtime PPP Corrector Service:
“Thomas Jefferson” uses the Fugro Marinestar satellite based corrector service to provide realtime correction
 to the horizontal position and ellipsoid height for all data acquisition and initial processing.  The corrector
 signal is received on the L1 channel of the POS MV primary GPS antenna and logged directly into the POS
 MV.  The data are then put out in real time to the EM2040, and positional and motion data are applied to the
 acquired bathymetry.  

In the event of issues with the real-time solution, the POS files produced during acquisition can be processed
 through the POSPac MMS software to produce an SBET in the WGS84 reference frame and an RMS file
 containing the realtime uncertainty estimates of the position and attitude data.

Inertially Aided Post-Processed Kinematic:
During post-processing horizontal positioning can be shifted to an Inertially Aided Post-Processed Kinematic
 (IAPPK) solution. The solution is created by combining GPS/GNSS satellite ephemeris and clock data with
 position information downloaded from a network of Continually Operating Reference Stations (CORS).
 The resulting position data is corrected for the effects of atmospheric interference on the GPS signal. The
 corrected GPS position is then combined with the vessel's inertial data using the POSPac MMS program to
 create a Smoothed Best Estimate of Trajectory (SBET). The resulting position can be used to apply higher
 quality navigation information to the processed data.

B.1.4.2 Vertical Control

Vertical Control methods for each project are specified in the project instructions, and utilize one of three
 possible methods:

-Zoned Tides: when using zoned tides vertical control is based on one or more NWLON stations operated
 by CO-OPS. Co-range and co-phase measurements from the NWLON stations are used to break the project
 area into zones, each of which has a distinct time-of-tide and range-of-tide corrector. CO-OPS provides the
 field unit with a Caris compatible file which takes observed water levels from surrounding gauges, computes
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 the time and range correctors for each zone, and uses the zoned data to reduce bathymetric soundings to
 MLLW. “Thomas Jefferson” does not install tertiary gauges in support of tidal modeling. After completion
 of a survey area, CO-OPS verifies all zoning and water level data.

-TCARI Tides: Tidal Constituent and Residual Interpretor is an alternative to discrete zoning. A TCARI grid
 is a triangulated network that uses two or more water level gauges to create a weighted network across the
 survey area. Each point on the grid has a discrete tidal interpolation that is based on the horizontal nearness
 of a water level gauge, the harmonic constants of the area, and the residual water levels. Bathymetric data
 is then reduced to MLLW using the TCARI tool in Pydro. Like zoned tides, CO-OPS verifies TCARI grids
 and observed water levels at the conclusion of each survey.

-GPS Tide: The IAPPK, 5P, or RT3P solution described in the Horizontal Control section can also be used
 to provide vertical control. Using this method the bathymetric data is initially referenced to the ellipsoid
 using the high accuracy position data. It is later reduced to MLLW using a separation model called VDatum,
 which is provided to the field unit by NOAA's Hydrographic Services Division.

B.1.5 Feature Verification

The following work flow is used to develop and verify features:
- The location of all potentially significant features are opened in Caris BASE Editor (BDB). Any indication
 of shoaling found in VBES data is also noted, and the area outlined in BDB;
- A development area polygon is exported from BDB and a line plan is created using ArcMap, creating line
 spacing that will ensonify all features with near nadir beams;
- Object Detection level MBES data is collected over all SSS contacts, VBES designated soundings, and all
 possible shoals. 

Quality of data is controlled through:
- Real time monitoring during acquisition to ensure that all features are covered by near nadir beams;
- Post processing inspection of the CUBE surface's Density, Standard Deviation, and Uncertainty layers;
- All developments are examined for significance. Objects found to be significant are flagged with a
 designated sounding, and become part of the Final Feature File.

B.1.6 Bottom Sampling

Bottom samples are collected in accordance with the recommended bottom sample plan provided in each
 survey's Project Reference File (PRF). The potential sample sites are examined by the Command and
 potentially culled based on the actual depths found during survey operations. Additional sample sites may
 also be added.

 “Thomas Jefferson” uses a winch-deployed Ponar Wildco. Once obtained, samples are analyzed for
 sediment type and classified with S-57 attribution using Caris BASE Editor. In the event that no sample is
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 obtained after three attempts, the nature of the surface is characterized as "unknown". Samples are discarded
 after field analysis is complete.

B.1.7 Backscatter

"Thomas Jefferson" processes all acquired backscatter into a mosaic using Fledermaus.

All backscatter data are logged using the SIS .all format.

B.1.8 Other

No additional data were acquired.

B.2 Data Processing

B.2.1 Bathymetry

B.2.1.1 Multibeam Echosounder

Five workflows exist depending on whether a survey uses zoned tides, TCARI tides, Marinestar service and
 the Real-Time Precise Point Positioning (RT3P) method, the Post-Processed Precise Point Positioning (5P)
 method,  or Inertially Aided Post Processed Kinematic (IAPPK) method. A more detailed description of 5P
 and IAPPK SBET creation is covered below in Section B.2.4.

These workflows are shown in descending order of preferred use.

-RT3P
1) Convert .all file into Caris project
2) Load Delayed Heave via Auxiliary Data Import
3) Sound Velocity Correction (note: no file is loaded in this step.  This is purely to apply Delayed Heave.)
4) Compute GPS Tide
5) Merge
6) Compute Total Propagated Uncertainty (TPU) using fixed uncertainty values (11cm for Marinestar, and
 the uncertainty value provided as part of the vDatum model)

-5P
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1) Create SBET and RMS files in POSPac MMS.
2) Convert raw .HSX data to Caris HDCS format 
3) Load Delayed Heave
4) Import ancillary data: SBET and RMS
5) Apply tide correctors. While unused, if available these are useful for a QC check in Subset Editor.
6) Compute GPS Tides using the provided VDatum SEP model.
7) Apply sound speed correctors
8) Merge; use GPS Tides.
9) Compute Total Propagated Uncertainty (TPU)

-IAPPK
IAPPK requires a delay of around 48 hours to produce the SBET and RMS files, due to reliance on updates
 of CORS station and ephemeris data.  The need for fast QC of the data ("night processing") to allow
 planning of the next day's survey operations necessitates that initial processing must happen before the
 IAPPK solution is available.  As a result, it initially follows the tidal scheme appropriate to that project area
 (Zoned Tides or TCARI).  Once sufficient time has passed, SBETs and RMS files are produced and the data
 is reprocessed using the same work flow as 5P, skipping the conversion and Delayed Heave steps.

-Zoned Tides:
1) Convert raw .HSX data to Caris HDCS format 
2) Load Delayed Heave
3) Apply tide correctors
4) Apply sound speed correctors
5) Merge
6) Compute 

-TCARI Tides:
The TCARI Tides work flow is the same as Zoned Tides except that Step 3 applies the TCARI correctors via
 Pydro, and Step 6 applies "realtime" tidal uncertainty values instead of project specific static values.

At this stage, all of the work flows merge into a common process.

1) Create CUBE surfaces. Surface resolution is dictated by the type of coverage required (Complete
 Coverage vs. Object Detection), and the depth of water. Disambiguation method is NOAA CUBE
 Parameters.
Compliance with HSSD gridding requirements is strictly observed.
2) Review the CUBE surface for holidays.
3) Create a holiday line plan.
4) Review the uncertainty and standard deviation layers and address areas where the standards set by the
 HSSD are exceeded.
5) Examine all surfaces for erroneous surface designation and evidence of systematic errors. Also identify
 features and look for evidence of shoaling.
6) Significant features are flagged 'designated', forcing the CUBE algorithm to honor the depth of the
 sounding.  Designated soundings are reviewed to ensure compliance with guidance in the HSSD.
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7) Create finalized grids. In finalization, the standard deviation for each node in the surface is multiplied by
 1.96 to provide the 95% (2-sigma) confidence level. Standard deviation is then compared to the computed
 Total Vertical Uncertainty (TVU) for each node. The larger of the two values is retained as the finalized
 Uncertainty for each node.  Finalization is also when the surface is forced to honor designated soundings.

Figure 14: This image intentionally left blank

B.2.1.2 Single Beam Echosounder

Single beam echosounder bathymetry was not processed.

B.2.1.3 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar bathymetry was not processed.

B.2.1.4 Specific Data Processing Methods

B.2.1.4.1 Methods Used to Maintain Data Integrity

All bathymetric data is moved through the Caris HIPS processing pipeline using a step-by-step method.
 Data integrity is maintained through the use of acquisition and processing logs, which track: acquisition of
 each line of data; conversion of the data; examination of ancillary sensor (navigation and attitude); and the
 application of heave, tides, SVP, and TPU. When processing an ERS survey using the 5P or IAPPK method,
 an additional log tracking the quality of SBETs is used.

B.2.1.4.2 Methods Used to Generate Bathymetric Grids

After initial processing the bathymetric data is gridded into BASE surfaces using the CUBE algorithm.
 This type of surface calculates a horizontal and vertical uncertainty for each sounding, derived from the
 combined uncertainty from each of the sensors that contributes data to the sounding (e.g water levels,
 tide zoning, attitude sensor error, navigation sensor horizontal position error, and sound velocity profile
 error). Individual soundings are then propagated to grid nodes, which takes on a depth value as well as an
 uncertainty value based on all the soundings that contribute to the node. The influence of a sounding on a
 grid node is limited to 0.707 times the grid resolution.

MBES data is gridded using the CUBE algorithm. Resolution is dictated by the Project Instructions, as well
 as section 5.2.2 of the HSSD. The disambiguation method used is always Density and Local. The settings
 used for Capture Distance Scale, Horizontal Error Scale, and Capture Distance Minimum are those listed
 in section 4.2.1.1.1.1 of the FPM. After creation, Uncertainty and CUBE surfaces go through a quality
 control process. During this process, the Depth, Uncertainty, Standard Deviation, and Density child layers
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 are examined for compliance with NOAA specifications. After the surfaces pass quality control, they are
 finalized. Uncertainty values for finalized surface come from the greater of either Uncertainty, or Standard
 Deviation.

B.2.1.4.3 Methods Used to Derive Final Depths

Methods Used
Cleaning Filters
Gridding Parameters
Surface Computation Algorithms

Description
Filters are used on a case-by-case basis as determined by the hydrographer. Refer
to the Descriptive Report for more information. Gridding parameters and surface
computation algorithms comply with the HSSD and are described above.

B.2.2 Imagery

B.2.2.1 Side Scan Sonar

1) Convert raw .sdf data using Caris SIPS;
2) Scan Navigation and Attitude data, flagging erroneous data as rejected;
3) Re-compute towfish navigation. This is when tow point offsets and horizontal layback is applied to the
 data;
4) Slant range correct each line of data;
5) A primary reviewer scans each line for significant contacts;
6) A secondary reviewer makes an independent check-scan of all lines, verifying contacts and checking for
 missed contacts;
7) If the Project Instructions call for 200% Side Scan coverage, the scanners check correlation of contacts
 between 100% and 200% coverage;
8) Correlation is also used to reveal systematic errors, particularly if a contact shows up on lines collected in
 opposite or orthogonal directions;
9) Create individual mosaics for 100% and 200% coverage. Examine for coverage;
10) If necessary, create a holiday line plan.

Figure 15: This image intentionally left blank

B.2.2.2 Phase Measuring Bathymetric Sonar
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Phase measuring bathymetric sonar imagery was not processed.

B.2.2.3 Specific Data Processing Methods

B.2.2.3.1 Methods Used to Maintain Data Integrity

Periodic confidence checks were completed to ensure integrity of data. These checks were completed by
 ensonifing a target in the outer limits of the range scale on either side of towfish. When this target was seen
 on the trace within ten meters of the target's actual position (the positional accuracy of a towed system), it
 was understood that data integrity was maintained. Additionally, integrity is controlled through the use of
 acquisition and processing logs.

B.2.2.3.2 Methods Used to Achieve Object Detection and Accuracy Requirements

Object detection from side scan imagery is obtained by acquiring the entire survey area two times, with
 survey lines in the second coverage offset halfway between the lines from the first coverage. This results
 in 200% Side-Scan Coverage with line spacing based on 80% of the range scale. To ensure positional
 accuracy, a side scan certification test is performed. Multiple passes are made on a discrete feature (1m cube
 when possible) that ensonifies the feature with each transducer at a distance approximately 15%, 50%, and
 80% of the range scale in use. A total of 12 passes are made and the feature must be detected in at least 10
 of the 12 pass. All survey lines are then processed and a contact created for the feature. Contact positions
 are plotted and compared to the actual position of the feature. The contacts must be within 5m of the actual
 position for hull-mounted systems and 10m for towed systems.

B.2.2.3.3 Methods Used to Verify Swath Coverage

Side scan sonar coverage is determined by creating mosaics using Mosaic Editor in Caris SIPS. Each 100%
 of coverage is evaluated independently for gaps in coverage. Any holidays noted in the mosaics must be re-
acquired in a manner that will ensonify the area from the same incidence angle as originally intended.

B.2.2.3.4 Criteria Used for Contact Selection

For water depths less than 20m, contact heights of 1m or greater are considered significant. For water depths
 20m or greater, contact heights of 10% of the water depth are considered significant. A feature is created for
 each significant contact.

B.2.2.3.5 Compression Methods Used for Reviewing Imagery

No compression methods were used for reviewing imagery.

B.2.3 Sound Speed

B.2.3.1 Sound Speed Profiles
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Sound speed profiles are acquired by two types of devices: CTD and MVP. Downloading and processing of
 all sound speed data is performed using Velocipy, a part of the HSTP supplied Pydro program suite.  Sound
 speed profiles are also loaded directly into SIS and applied in real time, with an option to re-apply later in
 HIPS in the event of problems.

B.2.3.1.1 Specific Data Processing Methods

B.2.3.1.1.1 Caris SVP File Concatenation Methods

All sound speed profiles are concatenated into master files using Velocipy.

Figure 16: This image intentionally left blank

B.2.3.2 Surface Sound Speed

Surface sound speed data were not processed.

B.2.4 Horizontal and Vertical Control

B.2.4.1 Horizontal Control

Realtime horizontal correctors are applied during acquisition from either USCG DGPS stations, or from the
 Marinestar satellite service.  In all cases, the necessary data for post processing of the position is recorded by
 the POS PCS into .000 files (when automatically split for file size, the file suffix increments to .001, .002,
 etc).  The post processing workflow varies based on using 5P (with the Marinestar service) or IAPPK (with
 DGPS).

Marinestar workflow:
1) Create a new project in POSPac MMS.
2) Drag all of the POS files into the new project window.
3) Wait for extraction and download of rapid ephemeris.
4) Run the GNSS-Inertial Processor. 
5) Export SBET files.

IAPPK workflow:
1) Create a new project in POSPac MMS.
2) Drag all of the POS files into the new project window.
3) Wait for extraction and download of ephemeris and CORS data.
4) Run the GNSS-Inertial Processor. 
5) Export SBET files.
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While very similar, the two are very different in practice.  The primary requirement for running MarineStar
 through POSPac is to change the reference system of the data to WGS84, with the added benefit of reducing
 the uncertainty of the solution by running the processing both forward and backward.  For IAPPK, there is
 a time delay of around two days waiting on upload of the CORS data and availability of ephemeris.  Slow
 satellite internet download rates can make the download of CORS data prohibitively slow and prone to
 failure.  The reprocessing of the solution using the CORS data and recorded raw observables takes around
 two hours per 8 hour platform survey day, as compared to 10-15 minutes for the same processing via 5P.
  For “Thomas Jefferson,” with 24 hours of ship acquisition per day and two launch acquisition periods
 of 9 hours, the IAPPK processing typically takes 10 hours per day compared to about one hour for 5P
 processing.

Figure 17: This image intentionally left blank.

B.2.4.2 Vertical Control

Methods vary based on project assigned vertical control.

If Zoned Tides or TCARI are assigned, all tidal data processing is done by CO-OPS.  Tides are then loaded
 in Caris or Pydro, respectively.

For ERS projects, a VDatum separation model (SEP) is provided with the Project Instructions.  This SEP
 and the GPS heights in either the processed HDCS data (RT3P) or the SBET) exported from POSPac (5P/
IAPPK are combined in Caris using the Compute GPS Tides command.  Reduction to tidal datum is then
 completed by checking the "GPS Tides" option during the Merge step in Caris.

Figure 18: This image intentionally left blank.

B.2.5 Feature Verification

Feature verification begins during initial data processing. When conducting Side Scan surveys the data
 is converted and scanned for contacts using 2 independent reviewers. All significant contacts are then
 developed using a MBES. When conducting Multibeam surveys, or when reviewing MBES developments
 over side scan sonar contacts, the least depths over navigationally significant features are flagged as
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 'designated soundings', then imported into Caris BASE Editor. Inside BASE Editor, each significant contact
 is given an S-57 attribution, and the hydrographer recommends charting action. The final deliverable is a
 Final Feature File (FFF) in .000 format.

Figure 19: This image intentionally left blank.

B.2.6 Backscatter

All backscatter data are logged in the SIS .all format. All acquired backscatter data are processed into a
 mosaic and delivered to AHB. All processing of backscatter is done using the FMGT module of the QPS
 Fledermaus software package.

Figure 20: This image intentionally left blank.

B.2.7 Other

No additional data were processed.

B.3 Quality Management

Prior to each field season, “Thomas Jefferson” and her survey launches perform an annual Hydrographic
 Survey Readiness Review, during which all multibeam echo sounders, vertical beam echo sounders, side
 scan sonars, positioning systems, sound speed measuring devices, lead lines, and leveling equipment are
 calibrated.

Prior to acquisition, the hydrographer ensures that all charted features are in the Composite Source File
 (CSF), and reviews the coverage requirements. During daily acquisition, a hydrographer monitors the
 cumulative uncertainties in position and attitude data, watches incoming data for errors, and compares
 the surface sound speed against full water column data for each CTD cast. During post-processing,
 navigation and attitude data is scanned using Caris HIPS and SIPS. Side Scan data is then examined for
 significant features by two separate individuals. Multibeam data is binned into a BASE surface using the
 CUBE algorithm, then undergoes directed editing using the Standard Deviation, Depth, Uncertainty, and
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 Hypothesis Count child layers. The HSSD allowed uncertainty is also calculated for each surface node,
 and compared against the actual uncertainty. Any systematic errors, problems in density, or areas of high
 uncertainty are addressed in the Descriptive Report. 

Before any data is to be submitted, it is reviewed by at least three experienced hydrographers who are
 signatories to the Descriptive Report.

B.4 Uncertainty and Error Management

Caris computes TPU based on both the static and dynamic measurements of the vessel and survey-specific
 information including tidal zoning uncertainty estimates and sound speed measurement uncertainties. Static
 offset values are entered into the Caris .hvf file. Dynamic (realtime) and sound speed uncertainties are
 entered using the Caris Compute TPU tool. Where TCARI tides are used, uncertainty is calculated and
 applied during application of TCARI tidal correctors to HDCS data.

All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in the
 included Appendix Folder, HVF Reports.  These HVF Reports are output from the Caris HVF Editor in a
 plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
 reproduce an HVF.

B.4.1 Total Propagated Uncertainty (TPU)

B.4.1.1 TPU Calculation Methods

TPU is calculated in Caris HIPS using the Compute TPU tool. The uncertainty values for each input into the
 TPU model can come from one of three sources: Realtime, Static, or Vessel.  Realtime values are provided
 from the sensor or processing package, such as POSPac RMS files.  Static values are those entered manually
 into the Compute TPU dialog, such as tidal zoning uncertainty and sound speed measurement uncertainties.
  These Static values are documented in each sheet's Descriptive Report.  Vessel values are taken from the
 HVF if no realtime or static values are available. 

B.4.1.2 Source of TPU Values

Uncertainty values entered into the HVF for the multibeam and positioning systems were compiled from
 manufacturer specifications sheets for each sensor and from values set forth in section 4.2.3.8 and Appendix
 4 - Caris HVF Uncertainty Values of the 2014 FPM.  Sound speed static values are derived from the
 guidance in the FPM.  Tidal uncertainty values are realtime if using TCARI, or static and provided with the
 Project Instructions for Zoned Tides or VDatum.  Realtime values for the sonar are provided by the sonar. 
 Realtime values for motion and navigation are output from POSPac via the RMS file.

All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in the
included Appendix Folder, HVF Reports. These HVF Reports are output from the Caris HVF Editor in a
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plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
reproduce an HVF.  

B.4.1.3 TPU Values

Vessel n/a
Echosounder n/a n/a 0 kilohertz

TPU Standard
Deviation Values

Motion

Gyro 0 degrees

Heave
0 % Amplitude

0 meters

Pitch 0 degrees

Roll 0 degrees

Navigation
Position 0 meters

Timing

Transducer 0 seconds

Navigation 0 seconds

Gyro 0 seconds

Heave 0 seconds

Pitch 0 seconds

Roll 0 seconds

Offsets

x 0 meters

y 0 meters

z 0 meters

MRU Alignment

Gyro 0 degrees

Pitch 0 degrees

Roll 0 degrees

Vessel

Speed 0 meters/second

Loading 0 meters

Draft 0 meters

Delta Draft 0 meters

B.4.2 Deviations

There were no deviations from the requirement to compute total propagated uncertainty.

C Corrections To Echo Soundings
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C.1 Vessel Offsets and Layback

C.1.1 Vessel Offsets

C.1.1.1 Description of Correctors

See included HVFs for information on applied correctors.

C.1.1.2 Methods and Procedures

See included HVFs for information on applied correctors.

C.1.1.3 Vessel Offset Correctors

Vessel See included HVFs for information on applied correctors.

Echosounder See included HVFs for information on applied correctors. See included HVFs for
information on applied correctors. 0 hertz

Date 2015-11-13

Offsets

MRU to Transducer

x 0 meters

y 0 meters

z 0 meters

x2 0 meters

y2 0 meters

z2 0 meters

Nav to Transducer

x 0 meters

y 0 meters

z 0 meters

x2 0 meters

y2 0 meters

z2 0 meters

Transducer Roll
Roll 0 degrees

Roll2 0 radians

C.1.2 Layback

Layback correctors were not applied.
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Additional Discussion

All offsets for “Thomas Jefferson”  were derived from full surveys performed by Kongsberg USA-contracted
 personnel and verified by HSTB. All offsets are tracked and updated as needed.

All sensor offsets for “Thomas Jefferson” were measured with respect to the vessel's reference point,
 then translated to the IMU. Offset values for the EM2040 are entered into SIS and the ship's Caris HIPS
 Hydrographic Vessel File (HVF), with the exception of the x,y,z offsets between the primary GPS antenna
 and the IMU. The distance between primary antenna and IMU is entered into POSView, which then feeds
 position relative to the IMU to all integrated sonars. All other offsets are applied to data during the SVP
 or Merge steps in processing of bathymetric data. Offsets are applied to side scan sonar data during the
 Recompute Towfish Navigation step.

All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in the
 included Appendix Folder, HVF Reports.  These HVF Reports are output from the Caris HVF Editor in a
 plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
 reproduce an HVF.

Additional Discussion

Towfish positioning is provided to Caris HIPS using cable-out values registered by the Totco cable counter
 and recorded in the SonarPro SDF files. SonarPro uses Payout and Towfish Depth to compute towfish
 positions. The towfish position is calculated from the position of the tow point using the cable-out value
 received by SonarPro from the cable payout meter, the towfish pressure depth (sent via a serial interface
 from the Klein 5000 TPU to the SonarPro software), and the Course Made Good (CMG) of the vessel. This
 method assumes that the cable is in a straight line. Therefore, no catenary algorithm is applied at the time of
 acquisition, but in processing, Caris SIPS applies a 0.9 coefficient to account for the catenary.

Layback error is calculated by running a side scan certification test. This test consists of running parallel to
 a known feature at varying ranges from nadir to ensonify the target in the near-field (approximately 15% of
 range scale in use), mid-field (approximately 50 % of range scale in use), and far-field (approximately 85%
 of the range scale in use). The test requires that each side of the sonar ensonify the feature at each of these
 areas in the swath. Then the test is repeated in a direction that is orthogonal to the original set of lines such
 that the feature is ensonified a total of 12 times. A successful test will detect the feature in at least 10 of the
 12 passes. For hull-mounted systems, the selected contact positions must be within 5m; for towed systems,
 the contact positions must be within 10m. Layback error is the amount of correction that must be applied to
 minimize the distance between contact positions.

C.2 Static and Dynamic Draft
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C.2.1 Static Draft

C.2.1.1 Description of Correctors

See Additional Discussion for information on static draft application.

C.2.1.2 Methods and Procedures

See Additional Discussion for information on static draft application.

C.2.2 Dynamic Draft

C.2.2.1 Description of Correctors

See Additional Discussion for information on dynamic draft application.

C.2.2.2 Methods and Procedures

See Additional Discussion for information on dynamic draft application.

C.2.2.3 Dynamic Draft Correctors

Vessel S222
Date 2015-11-07

Dynamic
Draft Table

Speed Draft
0 0

Additional Discussion

Dynamic draft for “Thomas Jefferson”  was measured using the Post Processed Kinematic GPS method
 outlined in section 1.4.2.1.2.1 of NOAA's FPM.  To reduce the effect of any potential current, reciprocal
 lines were run at each RPM step in order to get an average speed over ground for each RPM. This average
 speed was used to estimate the vessel’s speed through the water. Dynamic draft and vessel offsets corrector
 values are stored in the HIPS Vessel Files (HVF). 

In ERS surveys, those that use recorded GPS heights corrected via a VDatum SEP model to achieve tidal
 datum, the dynamic draft correction is not applied to the soundings.  

All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in the
 included Appendix Folder, HVF Reports.  These HVF Reports are output from the Caris HVF Editor in a
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 plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
 reproduce an HVF.

Additional Discussion

Static draft  is measured , a Sutron Bubbler system. The orifice was surveyed into the IMU reference frame,
 and a waterline height was calculated. A common waterline for the ship when fully loaded with fuel and
 ballasted normally is approximately 35cm below the reference point of the ship, but the waterline may
 change by as much as +/- 30cm over the course of a field season.

In ERS surveys, the Static Draft is not applied to the soundings.  

The waterline for “Thomas Jefferson” is measured at least weekly. When feasible, waterline measurements
 are taken before and after fueling or ballasting of the ship. The values are kept in a static draft log and
 periodically updated in the HVF. Once applied in the HVF, all affected lines have SVP re-applied and are
 then merged so that the updated waterline measurements will be applied.

All offsets, correctors, and values used in TPU calculation that are stored in the HVF file can be found in the
 included Appendix Folder, HVF Reports.  These HVF Reports are output from the Caris HVF Editor in a
 plain text document readable anywhere, and include all of the requested values for the DAPR necessary to
 reproduce an HVF.

C.3 System Alignment

System alignment correctors were not applied.

C.4 Positioning and Attitude

C.4.1 Description of Correctors

No description was provided.

C.4.2 Methods and Procedures

Vessel navigation and attitude is measured by the POS MV and recorded in the .all file created by SIS,
 supporting the RT3P pipeline. Navigation and attitude measurements not applied in real time (typically,
 only heave data) are applied during post processing in Caris HIPS using the attitude data recorded in the .all
 file. The POS MV TrueHeave data are logged within the POS MV .000 files and applied in Caris HIPS
 during post processing using the Import Ancillary Data command.  TrueHeave is a forward-backward
 filtered heave corrector as opposed to the real time heave corrector, and is fully described in section 6 of
 the POS MV V5 User Guide 2009. In the event of issues with the real time positional solution applied by
 SIS, SBET files are applied to soundings to increase the accuracy of the kinematic vessel corrections and to
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 allow the ability to reference soundings to the ellipsoid. Standard daily data processing procedures include
 post processing of POS MV kinematic .000 files using Applanix POSPac MMS and POSGNSS software
 using either IN-Fusion SmartBase, IN-Fusion SingleBase or Omnistar Precise Point Positioning (a reference
 to the previous commercial name of Marinestar) processing modes. After processing and quality control
 analysis of the post-processed SBET files is complete, the SBET and RMS files are applied to the HDCS
 data in Caris HIPS using the Import Ancillary Data command.  

Additional Discussion

As part of an HSTB-led Sonar Acceptance Trial, the EM2040 was calibrated in all frequencies and
 operational modes.  

As part of the annual HSRR, “Thomas Jefferson” conducted MBES calibration tests for each individual
 multibeam system on the ship and her launches. Multibeam systems with two frequencies required an
 individual test for each frequency. The procedure used follows that outlined in section 1.5.5.1 of the Field
 Procedures Manual dated April 2014. Timing bias was determined using the method of running the same
 line at different speeds. Pitch and yaw bias was determined using a target on the seafloor. Finally, roll bias
 was determined using the standard flat bottom method.  Offset values were derived using SIS' built-in patch
 testing tools

All calibration reports can be found in the Appendix Folder, Patch Test Reports.

C.5 Tides and Water Levels

C.5.1 Description of Correctors

Unless otherwise noted in the survey Descriptive Report (DR) or project Horizontal and Vertical Control
 Report (HVCR), the vertical datum for all soundings and heights is Mean Lower Low Water (MLLW).

C.5.2 Methods and Procedures

Reduction to MLLW is accomplished by a variety of means depending on the project.

Predicted, preliminary, and verified water level correctors from the primary tide station(s) listed in the
 Project Instructions may be downloaded from the CO-OPS website and used for water level corrections
 during the course of the project. These tide station files are collated to include the appropriate days of
 acquisition and then converted to Caris .tid file format using FetchTides. Water level data in the .tid files
 are applied to HDCS data in Caris HIPS using the zone definition file (.zdf) or, for TCARI, in Pydro using a
 TCARI model provided by CO-OPS.  Upon receiving final approved water level data, all data are reduced to
 MLLW using the final approved water levels as noted in the individual survey's Descriptive Report.



2016 DAPR Version 1           NOAA Ship Thomas Jefferson         

50

ERS surveys are reduced to MLLW via the application of the CO-OPS provided VDatum SEP model using
 the Compute GPS Tides tool in Caris.

In the event that shore-based vertical control is established via either base stations or tide gauges, a complete
 description of vertical control utilized for a given project can be found in the project specific HVCR,
 submitted for each project under separate cover when necessary as outlined in section 5.2.3.2.3 of the FPM.

C.6 Sound Speed

C.6.1 Sound Speed Profiles

C.6.1.1 Description of Correctors

Aboard “Thomas Jefferson,” the MVP free-fall fish is used to collect sound speed profiles.

C.6.1.2 Methods and Procedures

Seabird .cnv and MVP .bot files are collected when necessary and converted to .svp files using NOAA's
 Pydro/Velocipy program.  Additionally, .S12 files are created by the MVP software, and sent directly to the
 EM2040 computer via the SendToSIS utility.  .svp files are concatenated into one vessel specific master file
 per project. This method of applying sound speed to data is listed in the sheets processing log included in
 the Separates submitted with the individual survey.

C.6.2 Surface Sound Speed

C.6.2.1 Description of Correctors

Aboard “Thomas Jefferson,” surface sound speed is measured using a Valeport Thru-Hull sensor.

C.6.2.2 Methods and Procedures

The speed of sound at the transducer face is fed directly to the Kongsberg EM2040 and is used in real-time
 by the MBES for beamforming. 





Vessel Name: S222_EM2040_HSTB.hvf
Vessel created: February 27, 2017

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2016-278 00:00

Comments:
Time Correction(s) 0.000

Transduer #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:
Model:   em2040_300N
Serial Number:

Transducer #2:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

_________________________________________________________
Navigation Sensor:

Time Stamp:  2016-278 00:00

Comments:
Time Correction(s) 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:  (null)
Model:   (null)
Serial Number:  (null)

_________________________________________________________
Gyro Sensor:



Time Stamp:  2016-278 00:00

Comments:
Time Correction(s) 0.000

_________________________________________________________
Heave Sensor:

Time Stamp:  2016-278 00:00

Comments: (null)
Apply No
Time Correction(s) 0.000
DeltaX: -2.146
DeltaY: 2.923
DeltaZ: -5.022
Offset: 0.000

Manufacturer:  (null)
Model:   (null)
Serial Number:  (null)

_________________________________________________________
Pitch Sensor:

Time Stamp:  2016-278 00:00

Comments:
Apply No
Time Correction(s) 0.000
Pitch offset: 0.000

Manufacturer:  (null)
Model:   (null)
Serial Number:  (null)

_________________________________________________________
Roll Sensor:

Time Stamp:  2016-278 00:00

Comments:
Apply No
Time Correction(s) 0.000
Roll offset: 0.000

Manufacturer:  (null)
Model:   (null)
Serial Number:  (null)

_________________________________________________________
Draft Sensor:



Time Stamp:  2016-278 00:00

Apply Yes
Comments:
Time Correction(s) 0.000

Entry 1) Draft: 0.000 Speed: 0.000
Entry 2) Draft: -0.012 Speed: 0.972
Entry 3) Draft: -0.012 Speed: 1.944
Entry 4) Draft: -0.004 Speed: 2.916
Entry 5) Draft: 0.018 Speed: 3.888
Entry 6) Draft: 0.040 Speed: 4.860
Entry 7) Draft: 0.068 Speed: 5.832
Entry 8) Draft: 0.104 Speed: 6.803
Entry 9) Draft: 0.140 Speed: 7.775
Entry 10) Draft: 0.186 Speed: 8.747
Entry 11) Draft: 0.232 Speed: 9.719
Entry 12) Draft: 0.284 Speed: 10.691
Entry 13) Draft: 0.350 Speed: 11.663

_________________________________________________________
TPU

Time Stamp:  2015-001 00:00

Comments:
Offsets

Motion sensing unit to the transducer 1 
  X Head 1 2.146
  Y Head 1 -2.923
  Z Head 1 5.022

Motion sensing unit to the transducer 2
  X Head 2 2.450
  Y Head 2 -2.818
  Z Head 2 5.005

Navigation antenna to the transducer 1
  X Head 1 0.757
  Y Head 1 7.014
  Z Head 1 27.360

Navigation antenna to the transducer 2
  X Head 2 1.061
  Y Head 2 7.119
  Z Head 2 27.343

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.000 or 0.000'' of heave amplitude.
Measurement errors: 0.002
Motion sensing unit alignment errors
Gyro:0.030 Pitch:0.010 Roll:0.010
Gyro measurement error: 0.015
Roll measurement error: 0.003
Pitch measurement error: 0.003



Navigation measurement error: 0.100
Transducer timing error: 0.001
Navigation timing error: 0.001
Gyro timing error: 0.001
Heave timing error: 0.001
PitchTimingStdDev: 0.001
Roll timing error: 0.001
Sound Velocity speed measurement error: 0.000
Surface sound speed measurement error: 0.000
Tide measurement error: 0.000
Tide zoning error: 0.000
Speed over ground measurement error: 0.000
Dynamic loading measurement error: 0.000
Static draft measurement error: 0.000
Delta draft measurement error: 0.000
StDev Comment: (null)

_________________________________________________________
Svp Sensor:

Time Stamp:  2016-278 00:00

Comments:
Time Correction(s) 0.000

Svp #1:
-------------
Pitch Offset: -0.266
Roll Offset: 0.327
Azimuth Offset: 179.504

DeltaX: 2.146
DeltaY: -2.923
DeltaZ: 5.022

SVP #2:
-------------
Pitch Offset: -0.277
Roll Offset: 0.419
Azimuth Offset: 179.498

DeltaX: 2.450
DeltaY: -2.818
DeltaZ: 5.005

_________________________________________________________
WaterLine:

Time Stamp:  2016-278 00:00

Comments: (null)
Apply No
WaterLine 0.371

_________________________________________________________



Vessel Name: TJ_S222_Klein5000_SSS100_2015.hvf
Vessel created: June 23, 2015

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2015-001 00:00

Comments:
Time Correction(s) 0.000

Transduer #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:
Model:   Unknown
Serial Number:

_________________________________________________________
Navigation Sensor:

Time Stamp:  2015-001 00:00

Comments: (null)
Time Correction(s) 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:  Applanix
Model:   v4
Serial Number:  (null)

_________________________________________________________
Heave Sensor:

Time Stamp:  2015-001 00:00

Comments: (null)
Apply No
Time Correction(s) 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000



Manufacturer:  (null)
Model:   (null)
Serial Number:  (null)

_________________________________________________________
Pitch Sensor:

Time Stamp:  2015-001 00:00

Comments: (null)
Apply No
Time Correction(s) 0.000
Pitch offset: 0.000

Manufacturer:  (null)
Model:   (null)
Serial Number:  (null)

_________________________________________________________
Roll Sensor:

Time Stamp:  2015-001 00:00

Comments: (null)
Apply No
Time Correction(s) 0.000
Roll offset: 0.000

Manufacturer:  (null)
Model:   (null)
Serial Number:  (null)

_________________________________________________________
Tow Point:

Time Stamp:  2015-001 00:00

Comments: HSRR 2015
Time Correction(s) 0.000
DeltaX: 6.370
DeltaY: -42.550
DeltaZ: -4.800

Manufacturer:  Klein
Model:   5000 V2
Serial Number:

Time Stamp:  2015-117 00:00

Comments: HSRR 2015 SSS Cert Results
Time Correction(s) 0.000
DeltaX: 6.370



DeltaY: -42.550
DeltaZ: -4.800

Manufacturer:  Klein
Model:   5000 V2
Serial Number:

_________________________________________________________
WaterLine:

Time Stamp:  2015-001 00:00

Comments: HSRR 2015
Apply Yes
WaterLine 0.380

Time Stamp:  2015-166 00:00

Comments: With HSL's, after ballasting during Charleston port call. 
Apply Yes
WaterLine 0.441

_________________________________________________________



Vessel Name: TJ_S222_Klein5000_SSS200_2015.hvf
Vessel created: June 23, 2015

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2015-001 00:00

Comments:
Time Correction(s) 0.000

Transduer #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:
Model:   Unknown
Serial Number:

Depth Sensor:

Sensor Class:  Swath
Time Stamp:  2015-117 00:00

Comments:
Time Correction(s) 0.000

Transduer #1:
-------------
Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:
Model:   Unknown
Serial Number:

_________________________________________________________
Navigation Sensor:

Time Stamp:  2015-001 00:00



Comments: (null)
Time Correction(s) 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:  Applanix
Model:   v4
Serial Number:  (null)

_________________________________________________________
Heave Sensor:

Time Stamp:  2015-001 00:00

Comments: (null)
Apply No
Time Correction(s) 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Offset: 0.000

Manufacturer:  (null)
Model:   (null)
Serial Number:  (null)

_________________________________________________________
Pitch Sensor:

Time Stamp:  2015-001 00:00

Comments: (null)
Apply No
Time Correction(s) 0.000
Pitch offset: 0.000

Manufacturer:  (null)
Model:   (null)
Serial Number:  (null)

_________________________________________________________
Roll Sensor:

Time Stamp:  2015-001 00:00

Comments: (null)
Apply No
Time Correction(s) 0.000
Roll offset: 0.000

Manufacturer:  (null)
Model:   (null)
Serial Number:  (null)



_________________________________________________________
Tow Point:

Time Stamp:  2015-001 00:00

Comments: HSRR 2015
Time Correction(s) 0.000
DeltaX: 6.370
DeltaY: -42.550
DeltaZ: -4.800

Manufacturer:  Klein
Model:   5000 V2
Serial Number:

Time Stamp:  2015-117 00:00

Comments: HSRR 2015 SSS Cert Results
Time Correction(s) 0.000
DeltaX: 6.370
DeltaY: -42.550
DeltaZ: -4.800

Manufacturer:  Klein
Model:   5000 V2
Serial Number:

_________________________________________________________
WaterLine:

Time Stamp:  2015-001 00:00

Comments: HSRR 2015
Apply Yes
WaterLine 0.380

Time Stamp:  2015-166 00:00

Comments: With HSL's, after ballasting during Charleston port call. 
Apply Yes
WaterLine 0.441

_________________________________________________________
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Executive Summary 
A Kongsberg EM2040 multibeam and an EM710 MKII multibeam were installed aboard NOAA Ship 
Thomas Jefferson during an extended shipyard period at the Coast Guard yard in Curtis Bay in Baltimore, 
MD during the spring and summer of 2016.  After a short stay at the Atlantic Marine Operations Center 
in Norfolk, VA, the ship proceeded with acceptance testing of the new survey systems in the areas 
between Norfolk and Hudson Canyon during the third week of October, 2016, with the assistance of 
Office of Coast Survey and Kongsberg personnel. 

All portions of the Office of Coast Survey Sonar Acceptance Procedures were addressed, but the value of 
some tests were limited by the physical oceanography during testing.  While working to confirm proper 
integration and operation of the new survey systems some important limitations to the installation were 
uncovered and characterized. 

Key findings: 

1. Both the EM2040 and EM710 are properly integrated with the supporting sensors. 
2. A significant artifact presents itself in the outer beams of both multibeams.  This artifact is 

transient and not motion correlated.  While troubleshooting of this artifact is ongoing, at this 
time it is believed to be associated with the specific installation and not a defect in the 
hardware.  Efforts to solve this problem include: 

a. Bringing the paint covering both transducers to Kongsberg specifications. 
b. Removing the fairlead forward of the transducer installation.  

It is not yet known if these efforts will resolve this artifact.  In the interim it is recommended 
that the ship limit the survey swath to 45 degrees on either side by running in Single Sector 
mode, although the problem still persists at times even within the reduced swath. 

3. A backscatter artifact persists on the port side as a small section of depressed backscatter and at 
45 from vertical in the 200 kHz mode of the EM2040.  Efforts to solve this problem include: 

a. Bringing the paint covering the EM2040 transducer to Kongsberg specifications. 
b. Removing filler material added during the previous shipyard to smooth the surface 

around the transducer. 
c. Lowering the EM2040 transmitter to meet current Kongsberg specifications. 

 
It is not yet known if these efforts will resolve this artifact.  

 
4. A recommended Caris HIPS workflow had been provided to the ship.  This recommended 

workflow is recognized as restricted to specific steps and integrating specific data to avoid post 
processing pitfalls. 

While preliminary steps have been taken to remedy the problems described above, testing is still 
ongoing.  Coast Survey plans to stay engaged in finding and implementing a solution to the described 
artifacts such that the survey systems can be used to their full potential. 
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1 General Overview 
The NOAA Ship Thomas Jefferson was dry docked in the U.S. Coast Guard Curtis Bay Shipyard in 
Baltimore, MD, during 2016 to replace a defunct Kongsberg EM1002 with a new Kongsberg EM710 MKII 
1° x 0.5° multibeam echo sounder, and replace a pair of Reson 7125s with an EM2040.  Coast Survey 
Hydrographic Systems and Technology Branch (HSTB) personnel were on board for the acceptance 
cruise to assist OMAO Marine Engineering with integration and testing of the new systems. The cruise 
departed from Norfolk, VA on Friday, 14 October 2016, and returned to Norfolk on Thursday, 20 
October, with the ship traveling as far as the deep end of Hudson Canyon. 

Originally the USNS Littlehales, NOAA Ship Thomas Jefferson (Figure 1) is a 63 meter long hydrographic 
vessel built by Halter Marine in 1991.  Propulsion includes one main engine plus a bow thruster.  An 
additional smaller drive on the main shaft is only used for maneuvering.  Thomas Jefferson conducts 
bathymetric surveys in the Caribbean and the East Coast of the United States, generally in support of 
Office of Coast Survey.  Other echo sounders on the ship include a bridge fathometer, Doppler speed 
log, and several Simrad ES60s.  A Knudsen sub-bottom profiler transducer is mounted but has not been 
commissioned, and is thus not currently usable. 

 
Figure 1- NOAA Ship Thomas Jefferson in the Coast Guard yard. 

The Kongsberg EM2040 multibeam echo sounder is the second EM2040 in the NOAA fleet, but the first 
with the new “slim PU” design.  This version should be supported for longer with firmware updates 
extending the usable life.  The Kongsberg EM710 MKII multibeam echo sounder is the second of its kind 
in the NOAA Fleet, with one installed the previous year aboard NOAA Ship Nancy Foster.  Both the 
EM710 and EM2040 were mounted on a new pod (Figure 2) on centerline and near the location of the 
old EM1002.   Testing of the new echo sounders followed the HSTB Sonar Acceptance Procedures, 
version 1.0.  Visiting personnel to support acceptance work included Glen Rice from HSTB, Neil Weston 
from Coast Survey, with Paul Johnson and Dr. Anand Hiroji from the University of New Hampshire 
Center for Coastal and Ocean Mapping.  Anthony Dalheim from Kongsberg Underwater Technologies 
Inc. (KUTI) was also aboard to support installation and acceptance work. 
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Figure 2- NOAA Ship Thomas Jefferson survey transducers from below and looking aft. The Kongsberg EM710 MKII 1° x 0.5° 

system includes the top two transducers in center pod, while the EM2040 system includes the bottom two.  Also visible are the 
ES60 transducers in the pod on the right (port).  The left (starboard) pod has an intake for an inboard surface sound speed 

sensor. 

2 Overview of schedule and conditions 
2.1 Preplanning 
Planning for the acceptance cruise evolved with the personnel involved and timing of the cruise.  HSTB 
personnel coordinated with the ship’s command and Coast Survey to establish a plan for acceptance 
testing.  Eight days were allocated by Office of Marine and Aviation Operations for acceptance testing, 
including transit time. 
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Figure 3 - Acceptance testing planned locations as displayed on chart 13003. 

2.2 Executed Schedule 
 Tuesday, 11 October – Rice Arrives aboard in Norfolk 
 Wednesday, 12 October – Underway in Chesapeake Bay for crew familiarization.  Some initial 

integration testing and interference testing with the EM2040. 
 Thursday, 13 October – Initial attempt at a patch test but conditions are unsuitable.  Shallow 

water noise testing, some tests with doppler speed log on. 
 Friday, 14 October – Johnson, Hiroji, Weston and Dalheim arrive via small boat transfer to begin 

acceptance cruise. 
 Saturday, 15 October –Second attempt at EM2040 Patch Test at Bow Mariner wreck site. 
 Sunday, 16 October – Patch Test at Tom’s Canyon for EM710 and EM2040, EM2040 Extinction 

Test at Hudson Canyon. 
 Monday, 17 October – Extinction Test for EM710 and EM2040, EM710 Medium and Deep 

Accuracy Testing. 
 Tuesday, 18 October – Extinction Test for EM710 and EM2040, deep noise test for EM2040 and 

EM710. 
 Wednesday, 19 October – At Bow Mariner for EM2040 Accuracy, EM710 Shallow Accuracy, and 

EM710 and EM2040 Object Detection, EM710 and EM2040 Shallow Noise. 
 Thursday, 20 October – Multispectral backscatter testing, arrive in port. 

3 Pre-Installation Testing 
3.1 Test Data Processing Workflow 
NOAA Ship Thomas Jefferson’s new survey system required a different configuration and slightly 
different workflow than was used for past NOAA Kongsberg systems.  Other Kongsberg multibeams in 
the NOAA fleet have been configured with the reference point at the transmit transducer to overcome 
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deficiencies in the treatment of lever arms in Caris HIPS for these systems ([1], [2]).  Thomas Jefferson 
has two Kongsberg multibeam systems and they cannot both be identified as the primary reference 
point for the survey system.  In June of 2016, HSTB conducted an analysis of the updated CARIS HIPS 9 
ray tracing algorithm to confirm proper application of lever arms [3].  While this analysis showed the 
lever arm issue had been resolved, there are still post-processing impacts to the location of the 
reference point.  This is discussed further in Section 7.1. 

We also tested the application of the ellipsoid height from a raw Kongsberg *.all file using Caris 9.1 and 
Qimera 1.3.  Thomas Jefferson has regularly used MarineStar with their POS M/V to provide real time 
ellipsoid heights that can be used directly, cutting down on post processing time.  Heights are recorded 
within the Kongberg data both as the original NMEA string in the position record and as a separate 
height record.  Testing demonstrated that when the GGA NMEA message was used the resulting depths 
were referenced to mean sea level (MSL).  The GGA message format accommodates both the height 
relative to MSL as well as the separation to the ellipsoid used to derive MSL.  However, the POS M/V 
does not populate the separation value in favor of higher precision elsewhere in the record, which 
means there is a lack of specification in the derivation of the datum.  To avoid this ambiguity, Thomas 
Jefferson was configured to use the GGK message, which only contains ellipsoid heights.  This was done 
with the intention that ellipsoid heights could be pulled directly into Caris through the *.all file without 
the need to merge additional positioning files, thus streamlining the path to survey on the ellipsoid.  
Testing in both Caris HIPS and Qimera 1.3.6 was successful in producing ellipsoid referenced results. 

3.2 Determine data rates and file size 
We estimated the anticipated data acquisition rate using the data collected during the extinction test 
(Section 6.5).  The purpose of this analysis is to aid in the planning of appropriate storage volume for an 
anticipated survey.  Data rates with and without water column files are described.  Water column is 
recorded to a separate *.wcd file, but total water column rates should be considered the combined 
bathymetry and water column since both files are logged simultaneously.  The bathymetry files contain 
a number of records, including backscatter, attitude, vessel offsets and settings, etc.  No effort was 
made to quantify or predict the uncertainty associated with these estimates.  The data rates strongly 
depend on depth.  For example, the EM710 logs water-column data approximately 100 times faster in 
shallow water than in deep water.  This means that continuous logging of full water column may be 
practical in deep water (e.g. for methane seep detection), but may be prohibitive in shallow water.  

The EM2040 data collection rates without water column are shown in Figure 4. 
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Figure 4 - Data collection rates for the EM2040 without water column data. 

The EM2040 data collection rates with water column are shown in Figure 5. 

 
Figure 5 - Data collection rates for the EM2040 with water column data. 

The EM710 data collection rates without water column are shown in Figure 6. 
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Figure 6 - Data collection rates for the EM710 without water column data. 

The EM710 data collection rates with water column are show in Figure 7. 

 
Figure 7 - Data collection rates for the EM710 with water column data. 

3.3 Operational hazards 
No current environmental or safety regulations or hazards restrict use of this multibeam echo sounder. 
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3.4 Determine user configurable system settings 
The user configurable settings are as expected from past experience and relative to the SIS manual for 
an EM710 MKII and EM2040.   

The EM2040 has an additional setting that had previously not been tested.  It is possible to change the 
type of seafloor detection to “Min Depth”, which allows for the better capture of small targets in the 
water column.  The effects of this are discussed further in section 6.4.  

4 Configuration 
4.1 Sonar installation parameters 
4.1.1 Vessel Survey and Reference Frames 
Because Thomas Jefferson has two Kongsberg multibeams, the configuration successfully used on other 
platforms (i.e. setting the system reference point at the transmit array) could not work for both systems 
with a single POS/MV system. Because of the dual multibeam installation and only one possible primary 
reference point, the reference point was placed top dead center of the IMU, and all angular offsets were 
defined in the IMU frame. 

Both of the EM710 transducers, RX and TX, are mounted in what Kongsberg considers a “forward” 
configuration.  However, both of the EM2040 transducers are in what Kongsberg considers a “reversed” 
configuration.  While this is not expected to cause problems with the current post processing software, 
historically the reversed configuration has caused complications and is worth noting. 

The values used for lever arm offsets and angular rotations were based on the information provided by 
IMTEC, the survey company contracted by Kongsberg to conduct the vessel offset survey (included in 
appendix).  Tables were provided for the ship reference frame, the IMU reference frame, the EM710 
transmitter reference frame, and the ORU reference frame.  The raw survey x-y-z locations in the survey 
reference frame were also provided.  While the IMU reference frame table was used to describe all 
offsets and angles for the vessel configuration, the output from the IMU itself is rotated by the patch 
test values in SIS to bring it into alignment with the surveyed IMU frame.  

While alongside in Norfolk an investigation into the vessel waterline using the draft marks, the vessel 
ellipsoid height, and a hull mounted sutron gauge was undertaken.  A description of this work and 
results can be found in the appendix.  In short, we validated that all methods of obtaining draft were 
consistent within their precision and that the bubbler gauge was the most precise.  

The ship’s underway settlement was also estimated while underway in Chesapeake Bay using ellipsoid 
relative techniques in HSTB’s AutoQC tool.  These results were comparable with past dynamic draft 
tests. 

4.1.2 Data Flow Configuration 
The data flow for a Kongsberg multibeam is multilayered.  Multibeam data moves from the TRU to the 
SIS acquisition workstation.  Data can be sent directly from SIS or from two other Kongsberg programs 
on the SIS workstation to an external client.  While this flexibility provides many different options for 
configuration, it can also be confusing and easily confounded.  The approach taken for this installation 
was mixed.  The Kongsberg program, DataDistrobution.exe, was used to forward the multibeam data 
from the workstation to Hypack.  This program has been designated to autostart when the SIS 
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workstation is booted through the Windows Startup folder and must be allowed to run in the system 
tray or in the background at all times.  If this program is closed, data will not be delivered to Hypack.  
Sound speed packets were sent from a lower level data distribution program to Velocipy. 

The survey system was configured as described in Figure 8. 

 
Figure 8 - The Thomas Jefferson survey system configuration as of the acceptance cruise. 

Water column logging through SIS on both EM systems is licensed for the Thomas Jefferson.  When 
water column is logged a separate raw *.wcd file containing water column records is produced.  In 
addition, this file contains the attitude, position, system settings, installation parameters, and sound 
speed profiles.  While these records are duplicates of some of the bathymetry file contents, these 
records make the independent use of the water column data easier as no pairing or merging between 
the *.all and *.wcd files is necessary. 

A trigger cable to force the EM2040 to trigger from the EM710 transmit was built and installed by ship 
personnel as the request of the acceptance team.  Triggering in this fashion causes the two systems to 
ensonify the same piece of the seafloor which is valuable to multi-frequency backscatter work.  Enabling 
the trigger is completed within the EM2040 SIS software. 
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4.2 Ancillary equipment setup 
4.2.1 Position and Attitude 
The POS M/V was configured to send navigation (NMEA INGGK string) and attitude (Simrad 3000 (Tate-
Bryant)) through serial cables to the TRU for each multibeam though unbuffered serial data splitters.  An 
Ethernet connection from the POS M/V to each TRU was included for attitude velocity.  The POS M/V 
lever arms and rotations were configured with the IMU as the reference point as described in 4.1.1.  The 
POS M/V was checked to confirm proper connection to the primary / secondary antennas, and 
MarineStar support remained as previously configured.  Position and attitude were compared between 
SIS and the POS M/V and were found to be equivalent.  The POS M/V firmware for the PCS and GNSS 
cards could not be updated because the hardware was no longer under an Applanix maintenance 
contract. 

4.2.2 Surface Sound Speed 
There are three possible sources of surface sound speed aboard Thomas Jefferson, however both 
multibeams were configured to only receive data from the hull mounted Valeport sound velocity sensor 
during this cruise.  The Valeport surface sound speed probe was configured to send an AML message 
directly to SIS and was confirmed to work as expected. A benefit of using the Valeport is that it is 
mounted on a seacock such that it can be retracted and removed for easy servicing (Figure 9).  In 
addition to the Valeport, the ship has a TSG and a Reson sound speed sensor mounted in a flow through 
tank.   

 
Figure 9 – The Valeport in the retracted positon as mounted on a closed seacock.  When the value is open the sensor is deployed 

by pushing down on the black handles. 
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4.2.3 Profiling the Physical Characteristics of the Water Column  
An MVP with a CTD sensor was used during acceptance work.  The sensor was compared with a recently 
calibrated Seabird CTD, as well as being compared with values from the Valeport surface sound speed 
sensor, located at hull depth, and found to be working properly. 

Velocipy was configured to send new casts directly to SIS for both multibeams and to receive a message 
back noting that the cast was accepted by SIS.  All cast extensions were made in Velocipy using either a 
deeper cast or the World Ocean Atlas. 

Unfortunately, Casttime was not functioning during the cruise.  While Casttime was configured and 
working before leaving port, some configuration change that remained undetermined caused Casttime 
not to receive cast information from the MVP.  Had Casttime been running, some of the problems 
experienced during this cruise may have been alleviated.  It was expected that ship personnel would 
resolve this problem at a later date. 

4.2.4 Hypack 
Hypack was configured to accept data from SIS for real time display and communication with the bridge 
only.  For these tests, all multibeam data were logged through SIS.  We recommend that SIS be used for 
all future operational data logging as well. 

4.2.5 Vertical control 
Generally, the vertical reference for acceptance work was either the real time water level or the 
ellipsoid depending on the requirement for a consistent vertical reference for the seafloor depth.  The 
ITRF 2008 ellipsoid was realized through MarineStar integration with the POS M/V which was recorded 
both in the POS M/V files and in the Kongsberg *.all files.  Where a comparison to previous surveys was 
required, VDatum was used to shift from the ellipsoid to the applicable datum. 

5 Alongside Testing 
5.1 User interface and system control 
The user interface and system controls for the EM710 and EM2040 operated the same as for previous 
versions of SIS.  SIS 4.3.2 was installed on the EM2040, and SIS 4.3.0 was installed on the EM710.  Minor 
changes to SIS are EM model specific, and these two versions are essentially the same. 

5.2 System health self-tests 
SIS Built In Self Tests (BIST) of all types were performed for both systems, including the extended tests 
available through the TRU.  While all BIST tests passed, a single receiver channel (number 52) on the 
EM2040 showed a significantly different response, indicating a possible broken channel. 

5.3 Evaluate stave data 
See the discussion of BIST tests in 5.2. 

5.4 Backscatter quality assessment 
Backscatter quality was not assessed while alongside.  Please see 6.6 for a discussion of backscatter 
assessment and normalization while underway. 
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6 Underway Testing 
6.1 Patch Test 
Patch testing was attempted in two separate locations but completed for both systems over Tom’s 
Canyon, approximately 100 nm SE of New York City.  We attempted to complete the patch test of the 
EM2040 over the wreck of the Bow Mariner.  Because the wreck tests lead to inconclusive results the 
ship moved to Tom’s Canyon and patch tested both systems simultaneously.  This location had been 
used previously for patch testing the EM710 from NOAA Ship Nancy Foster.  The 60 meter drop from 
120 meters to 180 meters proved to be a good target for pitch and yaw lines.  Roll lines were conducted 
on top of the shelf just above the canyon, and confirmation lines were run across the canyon in a deeper 
section.  Patch test values are described for both systems in Table 1. 

Table 1 - Patch test values for both multibeams. 

All values are in degrees EM2040 EM710 
Roll  0.07 0.02 

Pitch -0.05 -0.05 
Yaw 0.70 0.05 

 

 
Figure 10 - The patch test lines at Tom Canyon.  On the left is a profile of the pitch line.  On the right is an overhead view of the 

relief and patch test lines.  Line 2 is pitch, 1 and 3 were for yaw, and 4 was for roll.  Line 5 is the confirmation line, with the 
maximum depth being at 450 meters. 

We calculated an attitude time delay of 10 ms using the correlation of roll rate with swath slope artifact 
as described in [4] using transit data from the EM2040 acquired after the Tom’s Canyon patch test.  
There were significant artifacts in the bathymetry as described in section 6.4, which reduce confidence 
in this estimate.  EM710 noise was such that no estimate could be made with the same set of lines.  
Subsequent work to improve the estimated time delay from the EM2040 data increased the estimate to 
11 ms (Figure 11) with a reported uncertainty of 2 ms at two standard deviations from the covariance 
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matrix used for line fitting.  Similar work to extract a time delay for the EM710 resulted in similar values 
to the EM2040.  This time delay is entered in to SIS for both multibeams and the SIS recorded attitude 
data time stamp is shifted accordingly for post processing.  This time delay is different than the 14 ms 
offset found with both NOAA ships Rainier and Fairweather but is sufficient until the outer beam 
artifacts are removed and a better estimate can be made.  The root cause of this time delay on this and 
other systems remains unknown.   

 
Figure 11 - Roll Rate to Swath Slope Correlation for the EM2040.  Green line is a linear fit. 

6.2 Acquire Reference Data Set 
Three reference datasets in different depths were acquired for the EM710.  One of these locations was 
used for the EM2040 as well.  These data are used to check for bathymetric biases across the swath by 
comparing survey data with a dense reference surface.  The IHO uncertainty standards (and similarly the 
NOAA specification) contain both a depth dependent and depth independent error component; the 
depth independent part (a in Equation 1) is intended to account for error sources such as vertical 
control and draft measurement, the depth dependent factor (b in Equation 1) accounts for integration, 
environmental,  and echo sounder performance .   

Equation 1: Vertical uncertainty limit equation from both IHO and NOAA Specifications.    ∗  

Because of the nature of these tests, the depth independent error parameters were not much varied, so 
it is more appropriate to evaluate the performance only against the depth dependent component (i.e. 
the ‘b’ parameter).  For both IHO order 1 and NOAA Specifications, this is 1.3% of water depth. 

EM2040 ACCURACY TESTING 
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The area to the north of the wreck of the Bow Mariner was used for the reference surface.  This area is 
flat and generally ~75 meters deep (Figure 12).  200 kHz, 300 kHz and 400 kHz modes were tested.  
Weather was 15 to 20 knots with seas 2 to 3 feet and with swells also 2 to 3 feet.  Current was from the 
north causing a set of approximately 6 degrees of heading when on line.  A number of artifacts were 
observed during these tests.  The combined effect of which obscured identification of any one problem.  
One of these problems was variable sound speed (Figure 13) at depth during testing.  This variability 
may have been caused by the propagation of internal waves.  This impacted the performance of 
EM2040 during this test, causing a larger apparent uncertainty than would be experienced during more 
stable oceanographic conditions.  Another artifact was a periodic, but non-motion correlated, leeward 
outer beam artifact that is still being investigated.  This artifact is discussed in more detail in section 6.4.  
The reference surface was created from the object detection lines filtered to remove outer beam noise.  
This analysis was conducted by accumulating data from several lines with opposing headings. 

 
Figure 12 - The accuracy test site at the Bow Mariner.  Accuracy data were extracted along the profile (blue line in top, plot in 

bottom).  The wreck can be seen as red in the bottom of the surface.  Depths are relative to mean lower low water. 
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Figure 13 – Sound Speed Profiles at the Bow Mariner site during object detection and accuracy testing.  There are significant 

changes in these casts between 10 meters and 60 meters of water depth.  

The comparison between these data was conducted on the ellipsoid in Qimera 1.3.6. 

The 400 kHz mode had a mean bias of less than 0.3% of water depth, which equates to 0.23 meters in 75 
meters of water.  While the pulse length was set to adjust automatically, during the 400 kHz tests the 
pulse length was 107 microseconds with a CW pulse. A sound speed artifact is evident in the outer 
swath due to the dynamic oceanographic conditions.  Soundings fell within 0.6% of the mean difference 
at two standard deviations.  Note the maximum swath angle for the 400 kHz mode is restricted 60 
degrees on each side. While these results meet expectations, these statistics should improve in more 
ideal oceanographic conditions. 

 
Figure 14 – EM2040 400 kHz accuracy results as a percent of depth.  The blue line is the mean difference between the reference 

surface and these data.  The pink region is 2 standard deviations from the mean.  IHO Order 1 is 1.3% for this location. 
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The 300 kHz mode had a mean bias at nadir of less than 0.1% of water depth, which equates to 0.08 
meters in 75 meters of water. While the pulse length was set to adjust automatically, during the 300 kHz 
tests the pulse length was 370 microseconds with an FM pulse.  A sound speed artifact is evident in the 
outer swath due to the dynamic oceanographic conditions.  Soundings approximately within 1.0% of the 
mean difference at two standard deviations inside a 130° opening angle.  While these results meet 
expectations, these statistics should improve in more ideal oceanographic conditions and once the 
additional artifact is resolved. 

 
Figure 15 – EM2040 300 kHz accuracy results as a percent of depth.  The blue line is the mean difference between the reference 

surface and this line.  The pink region is 2 standard deviations from the mean.  IHO Order 1 is 1.3% for this location. 

The 200 kHz mode had a mean nadir bias of less than 0.1% of water depth, which equates to 0.08 
meters in 75 meters of water.  The pulse length was set to adjust automatically, and during the 200 kHz 
tests the pulse length was between 431 and 517 microseconds with an FM pulse.  A sound speed artifact 
is evident in the outer swath due to the dynamic oceanographic conditions.  Soundings were 
approximately within 1% of the mean difference at two standard deviations and inside 130° opening 
angle.  While these results meet expectations, these statistics should improve in more ideal 
oceanographic conditions and once the additional artifact is resolved. 
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Figure 16 – EM2040 200 kHz accuracy results as a percent of depth.  The blue line is the mean difference between the reference 

surface and this line.  The pink region is 2 standard deviations from the mean.  IHO Order 1 is 1.3% for this location. 

EM710 ACCURACY TESTING 

Three separate areas were used for accuracy testing of the Thomas Jefferson EM710 MKII.  The modes 
Shallow, Very Shallow, and Medium were tested at the same Bow Mariner site used for the EM2040.  
Sound speed problems as discussed in the EM2040 section for the Bow Mariner site are also present for 
the EM710.  The EM2040 reference surface was used for the test, and was constructed from the 
EM2040 object detection data as described previously.  The 70 meter mean depth for this area would 
normally be collected in Very Shallow mode which is used by the EM710 MKII systems in automatic 
mode for depths between 0 and 100 meters. 

Flat areas in the proper depths suitable for accuracy testing of the deeper modes are rare within a 
reasonable steaming distance from Norfolk, VA and also not in the Gulf Stream.  Areas near the 
extinction line and just sound of Hudson Canyon were used for these deeper modes.  These sites had 
less than a 3° slope that ran across the reference surface.  Because there were fishing vessels in the area 
and this work was conducted at night, the MVP was not towed.  Medium and Deep modes were tested 
at more than one location to help provide some continuity between the locations.

Deep and Medium mode were tested in approximately 200 meters of depth (Figure 17).  A CTD to 170 
meters was taken at the medium depth site upon arrival.  The 200 meter mean depth at this site would 
normally be collected in either Shallow mode, optimized for depths between 100 to 200 meters, or in 
Medium mode, good from 200 to 300 meters water depth. 
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Figure 17 – The EM710 medium depth accuracy test site.  Accuracy data were extracted along the profile (blue line in top, plot in 

bottom).  Depths are to the ellipsoid. 

Deep, Very Deep and Extra Deep were tested in approximately 550 meters of water (Figure 18).  A CTD 
cast to a depth of 300 meters was taken in 600 meters of water with the extended point being 
interpolated linearly from the last section of the water mass.  The 550 meter mean depth for this area 
would normally be collected in Very Deep mode which is optimized for depths between 500 and 1000 
meters. 
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Figure 18 - The EM710 deep accuracy test site.  Accuracy data were extracted along the profile (blue line in top, plot in bottom).  

Depths are to the ellipsoid. 

Table 2 - A summary of the test location for each mode. 
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Figure 19

 
Figure 19 - EM710 Very Shallow Dual Swath mode accuracy results as a percent of depth.  The blue line is the mean difference 

between the reference surface and this line.  The pink region is 2 standard deviations from the mean.

Shallow mode was also tested in both Single and Dual Swath in the same location with similar results.  
Some noise is evident in the near-nadir region for this mode (Figure 20). 

 
Figure 20 - EM710 Shallow Dual Swath mode accuracy results as a percent of depth.  The blue line is the mean difference 

between the reference surface and this line.  The pink region is 2 standard deviations from the mean. 
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Medium mode was tested at both the Bow Mariner (shallow) site and at the medium depth site (Figure 
21, Figure 22).  The results from these two locations were comparable, with more noise near nadir 
evident at the shallower location.  To reduce the effect of the sound speed artifact at the medium site, 
we filtered the crossline to within +/- 15 degrees of nadir and generated the reference surface with 
these filtered lines.  We then used the main scheme lines to compare to the reference surface.  Because 
the main scheme lines were acquired closer to the time of the cast, they had less of an artifact.  By 
restricting the data collected later (cross lines) to the near nadir region and using the data collected 
closer in time to the cast (main scheme lines) the effects of sound speed are reduced.  In some cases 
there was significant nadir noise that was not displayed directly in the plot, but was reflected in the 
standard deviation (pink) part of the plot. 

 

 
Figure 21 - EM710 Medium Dual Swath mode accuracy results as a percent of depth at the Bow Mariner site (75 meters).  The 
blue line is the mean difference between the reference surface and this line.  The pink region is 2 standard deviations from the 

mean. 
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Figure 22 - EM710 Medium Dual Swath mode accuracy results as a percent of depth from the medium depth site (200 meters).  
The crosslines have been used to make a small nadir-only surface and compared to the main scheme lines.  The blue line is the 

mean difference between the reference surface and this line.  The pink region is 2 standard deviations from the mean. 

Unfortunately, the same approach to reducing the sound speed effects cannot be used for deep mode 
at the medium depth site since the main scheme lines were collected in medium mode.  Deep mode was 
tested in both Single and Dual Swath modes.  Dual Swath mode showed significant nadir noise (Figure 
23), while Single Swath mode show a large increase in noise in the starboard sector (Figure 24). 

 
Figure 23 - EM710 Deep Dual Swath mode accuracy results as a percent of depth from the medium depth site (200 meters).  The 
blue line is the mean difference between the reference surface and this line.  The pink region is 2 standard deviations from the 
mean. 
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Figure 24 - EM710 Deep Single Swath mode accuracy results as a percent of depth from the medium depth site (200 meters).  

The blue line is the mean difference between the reference surface and this line.  The pink region is 2 standard deviations from 
the mean.  The rapid change at +40 degrees is the port sector boundary. 

Very Deep and Extra Deep modes do not have Dual Swath capability and were thus only tested in Single 
Swath mode.  The data were within 1% of water depth at two standard deviations to the mean 
difference, which equates to approximately 6 meters at this location. 

 
Figure 25 - EM710 Very Deep mode accuracy results as a percent of depth from the deep site (~550 meters).  The blue line is the 

mean difference between the reference surface and this line.  The pink region is 2 standard deviations. 
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Figure 26 - EM710 Extra Deep mode accuracy results as a percent of depth from the deep site (~550 meters).  The blue line is the 

mean difference between the reference surface and this line.  The pink region is 2 standard deviations. 

6.3 Noise floor testing 
The purpose of noise testing is to assess sources of acoustic interference that may impact data quality.  
Also, establishing a baseline noise level provides for the opportunity to identify significant changes in 
the future.  Noise floor testing was completed in several locations for different conditions.  Tests were 
conducted using both the BIST RX Noise and RX Noise Spectrum functions in SIS as well as with water 
column in passive mode.  Passive water column is shown as averaged along each beam as a time series 
of all pings.  These data are then also averaged by each beam for each speed.  Averaging by beam 
assumes that noise is at a consistent angle relative to the vertical, and in the case where noise is 
transducer relative the noise may be smeared across several angles as the vessel rolls.  Averaging was 
completed in the linear domain after data outside of 3 standard deviations was removed from the time 
series.  EM2040 analysis on passive water column is limited to the even pings because the odd pings did 
not present usable data due to a firmware problem.  This problem was reported to Kongsberg and a fix 
is forthcoming.  Only the main engine was used during testing. 

A deep test area was chosen at the bottom of the extinction line in 2500 meters of water to minimize 
the effect of vessel noise reverberating off the seafloor.  Both the EM2040 and EM710 were tested at 
this site.  The weather was from the southwest at 15 – 20 knots with seas and swells at 2 – 3 feet.  Tests 
were conducted both into and out of the weather. 

Shallow water noise testing was undertaken in two locations.  The EM710 shallow area was southwest 
of the Bow Mariner wreck in a depth of 70 meters and was only conducted going into the weather, 
which was from the southwest at 15 knots and 2 – 3 feet.  EM2040 testing was also conducted in this 
location and under the same conditions.  In addition, noise testing was also conducted for the EM2040 
inside Chesapeake Bay during some of which the Doppler Speed log was also active. 

These results are presented in the following echo sounder specific sections. 
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EM2040 NOISE TESTING 

BIST noise tests are governed by preset Kongsberg settings but passive water column is sensitive to user 
settings.  The frequency mode is particularly important as it changes the echo sounder’s sensitivity to 
noise at particular frequencies.  Also, the maximum range setting changes the record length, with 
shorter record lengths opening gaps between water column records where burst noise might occur.  In 
this case the deep water noise testing had a frequency setting of 200 kHz and a record length of 500 
meters.  The shallow water testing the in Chesapeake tested all frequencies but had a record time 
equivalent to a 50 meters range scale.  The shallow water testing south of the Bow Mariner wreck had a 
frequency setting of 300 kHz and a record length of 100 meters. 

The deep water BIST noise and noise spectrum tests collected into the seas are shown in Figure 27 and 
Figure 28.  No significant change in background noise level with change in engine RPM was identified.  
Noise levels are generally low across all frequencies.  This indicates that the system is limited by internal 
noise rather than flow noise.  As noted in section 5.2, channel 52 appeared not to function correctly.  
There appears to be low background noise for all EM2040 frequencies as shown by the noise spectrum 
test. 

 
Figure 27 - Deep water BIST Noise tests heading into the seas. 
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Figure 28 - Deep water noise spectrum tests heading into the seas. 

Passive water column was also used to look at the beam formed deep water noise.  Figure 29 shows the 
entire into seas dataset (even pings only) with little identifiable change.  When dead in water (DIW) the 
noise was noticeably higher.  Figure 30 shows the data as averaged by beam and by speed.  In both 
figures there is coherent noise at boresight, and therefore transducer relative, and changes beam 
number as the vessel rolls.  If this analysis were conducted by averaging through transducer relative 
angles rather than vertically stabilized angles (beam numbers) the coherent noise would be even more 
apparent in the speed relative plot.  This coherent noise is likely electronic in origin.  

 
Figure 29 - Deep water noise from passive water column heading into the seas.  The EM2040 was in 200 kHz mode. 
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Figure 30 - EM2040 deep water passive water column noise averaged by beam and for each speed heading into the seas.  

EM2040 frequency setting was 200 kHz. 

EM2040 deep water noise out of the seas is shown for comparison to the previous plots in Figure 31.  
The same data for not making way is used as for heading into the seas, thus the apparent difference 
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between stopped and moving ahead in the previous plot is the same as between going into the seas and 
out of the seas, with heading down wind being a few dB higher. 

 
Figure 31 - Deep water passive water column noise averaged by beam heading out of the seas. 

EM2040 shallow water BIST noise testing from 14 meters of water within Chesapeake Bay is presented 
in Figure 32.  During the first set of tests the speed log was on and caused significant interference.  At 
500 RPM there is additional burst noise for the lower frequencies.  Figure 33 shows how the EM2040 
operates with low background noise across all frequencies with the same burst noise at 500 RPM.  
Again, the speed log was active during the first set of tests and was clearly interfering with all 
frequencies, although how it interfered depended on how the speed log transmit timed with the test. 
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Figure 32 – EM2040 RX Noise BIST Tests from 14 meters of water in Chesapeake Bay.  High, intermittent levels are interference 

from the Doppler speed log.  

 
Figure 33 - EM2040 RX Noise Spectrum test from 14 meters of water in Chesapeake Bay. High, intermittent levels are 

interference from the Doppler speed log.  
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Passive water column showed consistent noise results across all frequencies for all speeds as show in 
Figure 34, Figure 35, and Figure 36.  The speed log was secured for these tests.  The nadir noise spike is 
most significant at 300 kHz, but also exists for all speeds for the other frequencies.  A significant number 
of poor seafloor detections at nadir may result from this change in background noise in shallow water. 

 
Figure 34 – EM2040 passive water column noise for the 200 kHz mode as averaged by beam and for each speed in 14 meters of 

water. 

 
Figure 35 - EM2040 passive water column noise for the 300 kHz mode as averaged by beam and for each speed in 14 meters of 

water. 
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Figure 36 - EM2040 passive water column noise for the 400 kHz mode as averaged by beam and for each speed in 14 meters of 

water. 

Figure 37 through Figure 40 are included to further stress the effects of the bridge speed log on the 
EM2040.  The first two plots are for the 200 kHz mode, while the second two plots are for the 300 kHz 
mode.  The beam averaged passive water column shows the change in average backscatter levels by 
ping.  A single ping from each frequency setting is also shown to demonstrate the effect of the speed log 
in a real time view of the water column.  The speed log should be secured during multibeam acquisition. 

 
Figure 37 - EM2040 passive water column noise for the 200 kHz mode as averaged with each beam in 14 meters of water.  The 

speed log was active during this test. 
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Figure 38 – EM2040 passive water column from a single “ping” for 200 kHz mode.  Speed log interference is evident.  

 

 

 
Figure 39 - EM2040 passive water column noise for the 300 kHz mode as averaged with each beam in 14 meters of water.  The 

speed log was active during this test. 
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Figure 40 - EM2040 passive water column from a single “ping” for 300 kHz mode.  Speed log interference is evident. 

 

EM2040 noise testing was also conducted in approximately 70 meters of water as described previously.  
This dataset includes higher rates of speed than were collected in Chesapeake Bay and are thus 
presented here for completeness.  No significant speed dependent change in noise is seen in the RX BIST 
Noise test as shown in Figure 41, although there does appear to be some additional burst noise at 10 
knots.  The RX BIST Spectrum Noise test also shows good background results across all speeds with the 
same burst noise at 10 knots.  Background noise levels are higher in the Chesapeake data than for the 
deep water and 70 meter tests, indicating some effect from seafloor reverberation of vessel noise. 

 
Figure 41 - EM2040 RX Noise BIST Tests from 70 meters of water and into seas. 
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Figure 42 - EM2040 RX Noise Spectrum test from 70 meters of water and heading into seas. 

For comparison to the Chesapeake Bay data, the passive water column data from the 70 meter areas is 
in Figure 43 and Figure 44.  The background noise level is more on par with the deep water noise data, 
and the nadir noise spike is much lower for the slowest (DIW and 2.6 kts) and highest (5.6 kts) speeds. 

 
Figure 43 – EM2040 300 kHz passive water column averaged by beam, heading into seas in 70 meters of water. 
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Figure 44 – EM2040 passive water column in 70 meters of water averaged by beam and by speed while heading is into seas. 

These results do not indicate a specific recommended noise limited survey speed for the EM2040.  Flow 
noise above the DIW level is not observable in either shallow or deep water.  While the noise floor is 
higher in shallow water, it is not particularly dependent on speed and may or may not be due to the self-
noise of the ship itself.   

EM710 NOISE TESTING 

Passive water column testing for the EM710 was conducted in Shallow mode and with a 500 meter 
range.  These tests were conducted at the same location and time as the deep water EM2040 noise 
tests. 

Deep water noise testing did not demonstrate any speed dependence in the BIST noise tests for levels 
by channel or by frequency other than small burst noise at the highest speed (Figure 45, Figure 46).  
Both into and out of seas had similar results. 
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Figure 45 - EM710 RX BIST Noise by speed and heading into seas in 2500 meters of water. 

 

 
Figure 46 – EM710 RX BIST Noise Spectrum by speed and heading into seas in 2500 meters of water. 
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The beam formed passive water column showed more noise toward the outer swath at the highest 
speed, but the coherent noise at nadir remained at the same level (Figure 51, Figure 52). 

 
Figure 47 - EM710 passive water column averaged by beam, heading into seas in 2500 meters of water. 

 

 
Figure 48 - EM710 passive water column averaged by beam and by speed, heading into the seas in 2500 meters of water. 

Shallow water noise testing for the EM710 was conducted at the same location and time as the EM2040, 
and with the same settings as for the deep noise testing.  BIST RX Noise and Noise Spectrum tests do 
show a speed dependence in this depth of water (70 meters), with higher background noise at higher 
speeds.  Because this increase in levels was not observed in the deep area, this noise is likely not flow 
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noise, but rather propulsion related self-noise propagating to the receiver via a bottom-bounce acoustic 
(e.g. downward radiated propeller noise, machinery noise through hull, etc.). 

 
Figure 49 – EM710 RX BIST Noise by speed and heading into seas in 70 meters of water. 

 

 
Figure 50 – EM710 RX BIST Noise Spectrum by speed and heading into seas in 70 meters of water. 
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Passive water column confirms the speed dependent noise observed in the BIST Noise tests in this water 
depth with the EM710.  The change in background noise is most significant around nadir (as would be 
expected with an in-band bottom bounce noise source), which could potentially lead to noisier 
detections in this area of the swath at higher speeds and in shallow water.  There is no clear noise floor 
limiting cutoff in acceptable survey speed. 

 

Figure 51 - EM710 passive water column averaged by beam, heading into seas in 70 meters of water. 

 
Figure 52 – EM710 passive water column averaged by beam and by speed, heading into the seas in 70 meters of water. 
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6.4 Target detection and recognition 
OBSERVATIONS OF OBJECTS 

The Bow Mariner wreck site contains many objects that are useful for testing a system’s ability to detect 
and recognize an object.  Three objects were chosen to be investigated with both the EM2040 and 
EM710.  A debris field 1100 meters north of the wreck has an object that appears to stand 2.5 meters 
proud of the surrounding seafloor, which is 76 meters deep.  This object appears to be approximately 5 
meters wide.  In addition, the Bow Mariner has several masts that were used as objects for 
investigation.  The bow mast appears to stand 14 meters above the deck, which is at 55 meters of depth, 
with an unknown width.  The aft mast, just forward of the bridge, appears to stand 9 meters from the 
deck, which is 55 meters from the surface, and be 4 meters wide.   

The object detection performance of each multibeam was evaluated by counting the number of 
detections both on top and in total on the object above the seafloor.  While this counting method is 
somewhat subjective (i.e. identifying what sounding is on the “top” of an object, which in this case was 
simply within the observed cluster within approximately 0.2 meters of the average depth on top of the 
feature), the number of points that would change from one count type to another should not have a 
meaningful impact on the conclusion.  Figure 53 shows the object north of the wreck and illustrates how 
the points were counted. The EM2040 was in 300 kHz mode and the EM710 was in Very Shallow mode.  
The EM2040 was tested twice for each angle, once with the “Normal” detection mode and once with 
the “Min Depth” detection mode mentioned previously.  No manual cleaning of soundings was 
completed for this analysis, and while points that could be considered noise were tracked, they were 
few enough that they did not present any meaningful conclusion for survey operations.  

 
Figure 53 – The seafloor object 1100 meters north of the Bow Mariner wreck used for object detection work.  Depths are in 

meters from the ellipsoid. 

Lines were run at different offsets from the target to investigate the effect of across track angle on 
detections.  The sounding counts for the EM2040 from swath angles between -20 and 71 degrees from 
nadir as shown in Figure 54. 
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Figure 54 – The number of detections on the object by the EM2040 by angle and for the Normal detection mode and Min Depth 
detection mode.  “Top” is the number of detection on the top of the object, while “All” is for all points perceived to be anywhere 

on the object. 

The EM2040 appears to make more than half of its detections on the top of the seafloor object, making 
the representation of the least depth likely.  Past 40 degrees, there are still numerous detection on the 
feature, thus making detection of the existence of a feature likely, but the number of detections on the 
top of the feature drops off quickly.  Out to 65 degrees there are still detections on the object but the 
least depth is no longer reliably captured.  The min-depth setting did not substantially increase the 
detections on the top of this object. 

Using the same lines and methods, the sounding counts for the EM2040 from swath angles between -20 
and 71 degrees from nadir as shown in Figure 55. 
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Figure 55 - The number of detections on the object by the EM710 and by angle.  “Top” is the number of detection on the top of 

the object, while “All” is for all points on the object. 

The EM710 does not have as many observations on the object, potentially in part due to a slightly 
smaller transmit beam width.  Still, enough points are on the top of the object out to 40 degrees that the 
object will likely be recognized as its least depth if observed.  Outside of 40 degrees the number of 
points on the top of the object drops off quickly, though the total soundings on the object are still high.  
Like the EM2040, detection of an object outside of 40 degrees is likely, but reliable detection of the least 
depth may not be.   

The same analysis was completed for the bow mast on the Bow Mariner wreck (Figure 56).  The number 
of these detections was not as consistent as for the seafloor object, so the results are presented in 
tabular form (Table 3). 

 

 
Figure 56 – The bow mast feature as observed with the EM2040. 
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Table 3 – The number of EM2040 observations on the forward mast for the top of the object and total on the object by angle. 

Angle (Degrees) -30 22 71 
Top / Total, # of points, Normal Detection Mode 0/3 0/8 0/0 
Top / Total, # of points, Min Depth Mode 3/25 2/16 0/18 

 

While the EM2040 does detect the forward mast with soundings reported on the structure, out of seven 
passes for each detection mode this object was only observed on three lines.  Also, detections are only 
provided by the EM2040 on the upper part of the mast when the system is in “Mid Depth” detection 
mode.  Qualitatively speaking, the object would only have been recognized if the system was in Min 
Depth mode as the total number of detections and detections on the top of the structure made the 
structure appear real rather than just noise. 

The EM710 did not detect the bow mast on any of the survey lines. 

This analysis was repeated for an aft mast near the bridge superstructure (Figure 57). 

 
Figure 57 – The aft mast feature as observed in a single line with the EM2040. 

Table 4 - The number of EM2040 observations on the aft mast for the top of the object and total on the object by angle. 

Angle (Degrees) -8 35 45 58 
Top / Total, # of points, Normal Detection Mode 0/3 0/0 0/8 0/4 
Top / Total, # of points, Min Depth Mode 9/11 0/5 0/5 0/0 

 

While the EM2040 does detect the aft mast with sounding reported on the structure, out of eight passes 
for each detection mode this object was only observed on three lines for each mode.  Detections are 
only provided by the EM2040 on the upper part of the mast when the system is in “Mid Depth” 
detection mode.    While this structure appears to have more volume than the forward mast, from 
published pictures of the vessel it is also appears composed of a truss network rather than presenting as 
a solid target.  Also, this mast is observed within the side lobe reverberation of the bridge super 
structure due to the heading during survey, making it difficult to have a clean detection.  Qualitatively 
speaking, the object would only have been recognized if the system was in Min Depth mode as the total 
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number of detections and detections on the top of the structure made the structure appear real rather 
than just noise. 

The EM710 did detect the aft mast with 4 soundings, but these would not have made the object 
recognizable as a significant structure. 

Observations from the two targets on the wreck suggest that it helpful to run the EM2040 in Min Depth 
mode when conducting developments over a structure with vertical structures typical of anthropogenic 
features such as wrecks. The Normal detection mode appears to function just as well as Min Depth 
mode over natural seabed objects.  Min Depth mode did not appear to increase the amount of noise 
added to the dataset over Normal mode, either over the wreck or over the flat seafloor.  Even so, Min 
Depth mode is likely to produce detections on water column objects, such as fish schools, which are not 
desirable for hydrographic surveys.  Unless further compelling evidence is found, we recommend that 
Min Depth mode only be used during development work. 

As noted previously, the number of noisy points around objects was also tracked.  A screen grabs of the 
Bow Mariner is show in Figure 58 to illustrate the point.  In general, there is very little noise. 

 
Figure 58 – EM2040 data from the wreck without cleaning. 

It is worth pointing out, however, that when Kongsberg data is imported into Caris a significant number 
of rejected points may be included (Figure 59).  Kongsberg systems will produce interpolated or 
extrapolated data but flag them as such.  Caris imports this data and flags it as rejected by the echo 
sounder.  It is important not to reaccept these points. 
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Figure 59 – EM2040 data from the wreck, showing data rejected, interpolated, or extrapolated by the MBES as grey. 

SYSTEMATIC SURVEY SYSTEM ARTIFACTS 

During the acceptance cruise an outer beam bathymetric artifact was observed.  This artifact was 
particularly noticeable over flat seafloors, and could not be correlated to motion.  This artifact was also 
confounded by internal waves during targeted testing, further confusing its source.  An example of the 
artifact can be found in Figure 60 and Figure 61. 
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Figure 60 – The leeward artifact as observed in a single line of EM2040 data.  The top plot is a profile view of the swath, while 

the bottom is an overhead view of the line along which the profile was taken. Heading was toward the left. 

 
Figure 61 – The leeward artifact as observed in a single ping of EM2040 data.  Left is the swath cross section, right is the single 

swath profile colored by depth. 
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This artifact occurs over multiple pings, apparently moving toward nadir and subsequently moving 
outward again.  This artifact appears predominantly on the leeward side of the vessel, although can also 
exist on both sides when the weather is not abeam.  After extended review by Kongberg and HSTB, and 
thanks to additional data collected by ship personnel post-acceptance cruise, this artifact is believed to 
be due to some upstream source of micro bubbles.  The most likely sources of these bubbles could be 
one or more of three structures forward of the transducers, including a line cutter bar just forward of 
the transducer mount, a small appendage on the bow, or the bow thruster.  The bubbles are not directly 
detected in the water column data or noise testing, but appear to be changing the sound speed of the 
water.  Conceptually, as a cloud of microbubbles passes past the echo sounder, the beams are refracted 
away from nadir causing those beams affected to appear deeper.  While this theory has yet to be 
proven, there is currently no other explanation that accounts for the relative weather direction 
dependence of this artifact. 

Previous to the installation of the new survey echo sounders bubble sweep down was considered and 
discussed with field experts [5].  Because it was important to the U.S. Navy to conduct quality 
hydrographic surveys, previous testing of bubble sweep down of the Thomas Jefferson hull (as the USNS 
LittleHales) had been completed.  Of the three likely sources of bubbles forward of the transducers, two 
were added since ownership of the vessel passed to NOAA, the cutter bar installed with the gondola, 
and the bow thruster.  The cutter bar has been removed during a subsequent yard period, but no new 
testing for the artifact has been completed.  If the artifact still persists, the bow thruster remains the 
likely candidate for the source of the bubbles since it was added by NOAA.  Because abatement of 
bubbles with the bow thruster as the source will likely require significant modifications to the ship, plans 
for imaging the bubble cloud with cameras or imaging sonars has been discussed should the artifact still 
be present. 

The standing recommendation is for the ship to collect EM2040 data in single sector mode until the 
bathymetric artifact is resolved.  This restricts coverage to 45° on either side, reducing the likelihood 
that the artifact will be present in the collected bathymetry.  While this configuration is not ideal, and a 
frustrating situation for a brand new survey system, the ship regularly conducts side scan surveys where 
the multibeam is primarily used to fill in at nadir and gather general bathymetry.  In the short term 
limiting the data to only the good part of the swath will help avoid introducing questionable data into 
the survey workflow.  This problem clearly needs to be resolved such that Coast Survey can use these 
new tools to their full potential. 

6.5 Sonar Performance Parameters 
The useable swath width as a function of depth is important to survey planning, survey quality, and 
survey efficiency.  Both the EM2040 and EM710 were tested by running the systems up and down a 
slope and plotting the usable swath as a function of depth.  The usable swath width is defined by the 
outermost good beam on each side of the swath as reported by the multibeam.  Because seafloor type 
has a strong impact on the returned signal level, the achievable swath width does depend on the 
seafloor type. Ideally, we would run these tests over a steady slope of homogeneous (and known) 
sediment type.  It is worth noting, that the identified outermost good beam can still contain noise or an 
incorrect depth as it has only been designated “good” by the system. 

EM2040 EXTINCTION TEST 
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The EM2040 was tested for all frequency modes but left to automatically select the pulse length.  The 
planned location for EM2040 extinction testing contained significant amounts of fishing gear, thus a 
different testing location was selected on the fly.  While the improvised location for extinction testing 
had a suitable maximum depth, the minimum depth did not allow for all modes to clearly demonstrate 
how the system would perform in shallow water without considerable additional transit time.  Also, this 
location appeared to have a significant change in the seafloor type (Figure 62) which caused an 
abnormal inflection in the extinction curve at approximately 200 meters (Figure 63). 

 
Figure 62 - A line in 300 kHz mode from the first extinction site demonstrating the change in backscatter as seen in QPS FMGT. 

 
Figure 63 – EM2040 extinction data at the improvised location. The pulse length was selected by the system automatically.  

Shown are the outermost good detections on each side of the swath. 
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To supplement this test, the EM2040 was also run during the EM710 extinction test.  200 kHz data was 
collected while steaming down the slope, and 300 kHz data was collected while steaming up the slope 
(Figure 64).  These results have a smoother transition between depths than the improvised location as 
would be expected for a consistent seafloor type over the test area. 

 
Figure 64 – EM2040 extinction testing on the EM710 extinction test line.  The pulse length was selected by the system 

automatically.  Shown are the outermost good detections on each side of the swath. 

For all three frequency modes the Thomas Jefferson EM2040 appears to meet the Kongsberg specified 
swath width by depth within the uncertainty of variability due to seafloor type.  In general, the 
performance follows the predicted extinction curve for a cold ocean with a sandy seafloor.  The 
variability of the results with apparent seafloor type is expected, and worth remembering when 
planning surveys using these plots.  Results will vary based on the seafloor conditions encountered in a 
particular area.   

EM710 MKII EXTINCTION TEST 

The EM710 extinction line ran from 75 meters down to 2500 meters of depth along the southern side of 
Hudson Canyon.  This appears to be a good location for this test as the slope has minimal interruptions 
from canyons between the applicable depths that would interfere with the results.  The EM710 was left 
to select the mode automatically, and was only tested in the 40 – 100 kHz mode.  The other modes (e.g. 
40 kHz mode, 50 kHz mode, and 70-100 kHz mode) largely use sub-modes of the 40 – 100 kHz modes, 
and Thomas Jefferson is expected to have no need to operate in these specific modes. 
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Figure 65 – EM710 extinction test results.  The mode setting was selected automatically.  Shown are the outermost good 

detections on each side of the swath. 

The EM710 MKII follows the predicted seafloor performance predicted for a cold ocean with a rocky 
seafloor.  While no seafloor samples were taken during acceptance testing, it is unlikely that the seafloor 
was rocky during the duration of the line.  Assuming the seafloor was not rocky, the EM710 likely 
exceeds the predicted Kongsberg performance swath width by depth performance. 

6.6 Backscatter quality assessment 
Kongsberg multibeam echo sounders adjust the recorded seafloor backscatter to account for beam 
pattern effects.  The real time backscatter can be improved and made more useful by updating this 
adjustment with values post-installation.  To accomplish this, some form of backscatter calibration 
needs to be completed to update these parameters.  Currently these parameters can be adjusted on the 
EM710 but not on the EM2040.  The BSCorr.txt file stored on the TRU contains the power level used for 
each sector of each mode as well as the relative receiver sensitivity by angle.  Previous methods 
adjusted the sensitivity settings to account for the differences in backscatter levels between sectors and 
modes.  For Thomas Jefferson only the power levels were adjusted to align the sectors. 

Two types of backscatter calibrations were used during this cruise for the EM710 modes mostly likely to 
be used aboard Thomas Jefferson.  Time was not taken to calibrate the lesser modes less likely to be 
used (e.g. 40 kHz, 50 kHz , 70 – 100 kHz) since the available time for calibration was not clear when in 
the proper locations.  The same method for collecting calibration data as was used in the past, consisting 
of a single line in each direction for each mode over a flat seafloor, was used in this case as well.  
Because of limited time for analysis, implementation, and testing, only the power offset was used to 
normalize between sectors.  This approach improved the real time backscatter considerably (Figure 66) 
while also simplifying the changes needed to the Kongsberg BSCorr file.  Modifying the angle sensitivities 
can be laborious if undertaken by angle as has been done previously. 
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Figure 66 – Seafloor backscatter with the EM710 before the BSCorr.txt file was adjusted (left) and after adjustment (right). 

The relative changes made to the port and starboard sectors to match the backscatter produced by the 
center sector are listed by mode in the summary in Table 5.  The center sector was left with the default 
power value.  The units for the sector power are not defined but are assumed to be some form of 
transmit power in dB. 

Table 5 – The updates made to the default EM710 BSCorr sector power. 

 Port Adjustment (KM Units) Starboard Adjustment (KM Units) 
Very Shallow – Dual Swath 1 +8.0 +8.0 
Very Shallow – Dual Swath 2 +8.0 +8.0 

Shallow – Dual Swath 1 +7.5 +8.0 
Shallow – Dual Swath 2 +9.5 +9.5 
Medium – Dual Swath 1 +6.0 +7.0 
Medium – Dual Swath 2 +7.0 +8.0 

 

Data were also collected for a secondary approach which was developed Dr. Anand Hiroji.  These lines 
were run to determine the full transmit beam pattern as described in [6].  Dr. Hiroji continuous work on 
these data and will provided results to the ship when complete.  

While the EM2040 backscatter was not calibrated, observation of the backscatter showed an 
unexplained artifact when operating in 200 kHz mode (Figure 67).  This artifact appears as an area of 
depressed backscatter on the port side at 30 degrees from nadir, roughly where sector boundaries 
would be expected if 200 kHz had three sectors.  The 200 kHz mode only has two sectors. 
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Figure 67 – The EM2040 200 kHz mode backscatter artifact. 

Kongsberg identified changes to the installation that may remove or improve this artifact.  Kongsberg 
was primarily concerned that the EM2040 transmitter was not protruding down from the cover plate 
sufficiently, and that the faring compound around the transducer may be interfering with transmission.  
In addition, they also recommended changing the amount of paint coating the transducers.  They 
considered the amount of paint evident on the transducers from pictures excessive, and felt that it could 
also be impeding performance.  These recommended adjustments were accomplished during a follow 
on shipyard period but testing to quantify any improvement has not yet been completed. 

7 Data Workflow Integration 
7.1 Test application of post processed correctors 
Post processing for the Thomas Jefferson acceptance cruise was conducted in Caris HIPS versions 9.1 and 
Qimera 1.3.  With previous Kongsberg installations in the NOAA fleet ([1], [2] ,[7]), the reference point 
was set as the transmitter of the echo sounder, and the output of the inertial navigation system was 
valid at this point.  This configuration was chosen in those cases to eliminate the lever arm calculations 
in Caris, which had a known deficiency in applying delayed heave corrections for Kongsberg systems.  
For the Thomas Jefferson, we elected to make the IMU the reference point (see section 4.1.1 for more 
information).  This choice was primarily motivated by the fact that with two multibeam systems and a 
single positioning system we could not have the reference point uniquely at each transmitter.  This 
configuration is also common NOAA practice (for non-Kongsberg systems) and seems to be more 
intuitive to many.  As tested in [3], the former lever arm related delayed heave errors seem to have 
been resolved in Caris 9.1, however survey work following the cruise in shallow water with extreme 
pitch revealed a residual pitch-related error and pointed to a complication with the desired HIPS 
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workflow.  A discussion of the current HIPS logic for Kongsberg systems as well as how the current 
version of SIS effects the workflow is provided here for clarity. 

Kongsberg systems provide the end user with both a processed sounding solution and the angle-range 
raw data.  Because the processed solution requires the application of many adjustments to the real time 
data, some of the data, such as the motion data, can be modified from its raw state.  Most notable to 
this discussion, the motion data is modified according to the lever arms and angles provided in the 
Installation and Test Parameters Sensor Setup tab (Figure 68).  Roll, pitch and heading have the values 
applied from the Attitude fields (commonly the patch test values), and heave is modified to account for 
the induced heave due the lever arms from the motion sensor to the transducers when the vessel is 
pitching (Figure 69).  Thus the logged real-time attitude data in the .all file is valid at the transmitter and 
in the transmitter frame.   Because the real time solution is provided as vessel (reference point) relative 
x, y, and z sounding locations, the navigation data is not translated.   

 
Figure 68 - The Installation and Test Parameters, Sensor Setup, Angular Offsets for the NOAA Ship Thomas Jefferson EM2040. 
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Figure 69 - Pitched induced heave (red arrow) is a result of the along track lever arm between the reference point (RP) and 

transducers (TX). 

In summary: the SIS logged real-time attitude (including heave) is valid at the transmitter and in the 
transmitter frame; real-time navigation, including GNSS height information (e.g. GGK and EM Height 
records), are valid at the ship reference point. 

This difference in reference frames only becomes an issue in Caris HIPS when applying post-processed 
navigation and attitude data.  The primary reason for post applying any post-processed data is the 
quality of the vertical information.  Delayed heave or a post processed ellipsoid height can both 
significantly improve on the real time solution, so it is desirable to have the option to apply these 
adjustments in post processing.  While a vertical offset can be straightforward to apply, the valid 
location of the available vertical positioning data is important for proper accounting for the effects of 
the motion induced heave.   

Caris HIPS is designed around the integration of sensor data described in a single reference frame with 
one sensor for each type of data.  The Hydrographic Vessel File (HVF) describes the offsets between the 
different sensors being integrated and accounts for those offsets where required.  Processing Kongsberg 
multibeam data within this framework is complicated by the existence of two possible reference frame 
existing within the provided data.  While in general Kongsberg data is meant to provide all data in the 
vessel reference frame (patch test values are applied to motion information, ray traced soundings, etc), 
real time heave and all raw transducer data (ranges and angles) are also provided in the transducer 
reference frame.  The Caris HVF accounts for this dual state by not applying any motion (everything is 
apply = no) or offsets (Swath offsets are zero) when the real time ray-traced solution is imported, but 
does account for these offsets or motion when reprocessing during ray tracing (SVC).  This is the reason 
for the transducer lever arms provided in the SVP portion of the HVF.  In theory reintegrating the motion 
information is straightforward because all lever arms and angular offsets have already been applied to 
the Kongsberg data.  Problems do arise when the data provided in post processing are not in the same 
reference frame as the Kongsberg frames.  In our case, delayed heave or GPS height information. HIPS 
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can handle different configurations, but a different HVF may be required depending on the sensor and 
workflow (e.g., SVC or no SVC, true heave or real time heave).  Most significant to this discussion of the 
HVF configuration is the description of the heave sensor location- as configured, the real-time heave is 
reported in a different place than the delayed heave, but there is only one ‘heave’ field in the HVF.  

It would seem the logic of the HVF would require a lever arm for the heave sensor when using 
Kongsberg real time heave (Kongsberg reported heave has the induced heave included and is therefore 
valid at the transducer as mentioned previously), but the HVF requires no offset for the heave sensor 
when reintegrating the real time heave during SVC.  All other data is either valid at the reference point 
or has offsets as described by the Caris technote on converting Kongsberg data [8].  This inherently calls 
into question the reference frame of the HVF for Kongberg data – is the HVF in the vessel reference 
frame or the transducer reference frame?  When conducting SVC in HIPS the reference frame appears to 
be in the transducer reference frame (with the exception of the SVP fields).  When no SVC is conducted 
the reference frame appears to be in the vessel reference frame. 

When no SVC is conducted, the description of the heave sensor lever arm is only important for 
computing GPS Tides.  For the proper removal of heave from the GPS tide height, the HVF heave sensor 
field must have a lever arm equivalent to the distance from the reference point to the transmit 
transducer.  When computing GPS Tides the “MRU remote heave” box must be checked such that the 
heave is moved back to the reference point and properly applied to the GPS height.   While this is 
essentially the desired workflow, i.e. all data is to the ellipsoid using all real time data, this method was 
deemed too inflexible since it precluded a water level referenced workflow free from heave artifacts.  
Because the position of the heave sensor is ambiguous (real time heave is at the transducers but 
delayed heave is at the reference point), there is not a way to apply delayed heave during merge only in 
HIPS.  While the difference between real time and delayed heave is the same everywhere on the vessel, 
this difference needs to be computed at the same location such that the induced heave is canceled out.  
It is possible to compute this difference directly from the Applanix True Heave record where both the 
real and delayed heave are reported, but HIPS differences the delayed heave with the real time heave 
from the Kongsberg file which adds back the induced heave artifact. 

When SVC is conducted in HIPS the HVF appears to describe the sensors in the transducer reference 
frame.  SVC may be conducted with zero offsets for all sensors besides the transducers, and results 
comparable to the real time reported values are produced.  The computation of GPS Tides is 
complicated by the fact that the valid location of GPS tides is at the reference point and not at the 
transducer, and there is no entry in the HVF for the location of GPS Tides.  To circumvent this problem 
delayed heave must be applied to the data.  By including an entry in the HVF that describes the location 
of the reference point, and thereby delayed heave, for the heave sensor relative to the transmit 
transducer, heave is correctly applied to the bathymetry.  This means a lever arm opposite to the SVP1 
field is entered for the heave sensor and provides for an SVC inclusive workflow that references the 
survey to the waterline.  To compute GPS tides the “MRU remote heave” box is not check because 
delayed heave and the GNSS height are both already at the reference point.  While this workflow 
requires delayed heave and the SVC step in post processing, it provides for the most flexible workflow 
and is recommended for Thomas Jefferson with their current configuration. 

The application of “Waterline” during the computation of GPS tides also deserves discussion here.  If 
data are converted with the GPS Height as GGK then the waterline needs to be applied during GPS Tide.  
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Because SIS applies the waterline value from the Installation Parameters to the EM Height, if the data 
are converted with GPS Height as EM Height the water line does not need to be applied when 
computing GPS tides.  For this reason the recommended workflow for Thomas Jefferson is to convert 
with EM Height but not apply waterline during the GPS Tide computation. 

While much of this confusion could be alleviated if Caris accommodated multiple potential heave sensor 
(e.g. real-time, post-processed) within the HVF (i.e. the real time Kongsberg reported heave required a 
lever arm entry), Caris stated in the helpdesk ticket while exploring this problem that their HVF 
configuration will not be revisited until Caris HIPS 11.  For a discussion of this solution please see the 
NOAA - Caris helpdesk ticket request ID 01602680. 

To accommodate the current processing restrictions, maximize potential workflow flexibility, and limit 
the number of unique HVF files, we implemented the following workflows: 

1) ERS  
a. Convert MBES data  Load Delayed Heave  Sound Velocity Correct  Compute GPS 

Tides  Merge with GPS Tides  TPU 
 

2) Traditional Water Levels  
a. Convert MBES data  Load Delayed Heave  Load Tides  Sound Velocity Correct  

Merge  TPU 

Thomas Jefferson’s HVF has also been modified to account for Total Propagated Uncertainty (TPU) with 
MarineStar (which does not have real time uncertainty reported correctly), but again to maximize 
flexibility while limiting unique HVFs.  Entries associated with the real time water level reference 
uncertainty, such as heave, static and dynamic draft, which together have a root sum square value of 
0.09 m, have been removed from the HVF.  When surveying to the ellipsoid, a value of 0.11 m for the 
MarineStar uncertainty is entered into the Tide/Measured dialog.  This value was derived as an average 
of all 2015 Thomas Jefferson ship (no launches) POSPac PPP projects compiled by Physical Scientist 
Faulkes.  The VDatum uncertainty from the project instructions is entered into the Tide/Zoning dialog.  
When surveying to the waterline, the Tide/Measured dialog will include the values that were removed 
from the HVF as a single value of 0.09 m, and the projects instructions will inform the value for the 
Tide/Zoning dialog. 

For details, please see the Standard Operating Procedure for Thomas Jefferson’s Caris HIPS configuration 
and conversion in the appendix. 

7.2 Test data resolution and density 
As with past Kongsberg multibeam echo sounders, Thomas Jefferson’s survey system meets Coast 
Survey sounding density specifications.  The density estimates, as calculated from the extinction lines, 
for the EM2040 can be found in Figure 70, and the EM710 in Figure 72.  Ping rates as measured from 
these same data can be found in Figure 71 and Figure 73 for the EM2040 and EM710 respectively.  
Unfortunately, the EM2040 extinction was not tested specifically in shallow water where the density 
estimate would be most applicable. Past testing with the EM2040 [10] demonstrates that the EM2040 
will meet NOAA density specifications in shallow water. 
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Figure 70 – Sounding density for the EM2040 estimated from the extinction lines. 

 

 
Figure 71 – Ping periods for the EM2040 during the extinction lines.  
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Figure 72 – Sounding density for the EM710 estimated from the extinction lines. 

 

 
Figure 73 – Ping period for the EM710 during the extinction lines. 
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7.3 Test total propagated uncertainty 
Kongsberg produces real time uncertainty for the echo sounder component of the uncertainty model 
according to the method recommended by Ifremer [9].  These records can be ingested by Caris to 
contribute toward the sonar portion of the Total Propagated Uncertainty (TPU).  Data were evaluated 
using data collected during the object detection portion of this cruise and using the HIPS configuration 
described in 7.1.  For reference, IHO Order 1a for 75 meters of depth is 1.1 meters.  At nadir the 
uncertainty was 0.406 meters, and for the outer beams it was 0.737 meters.  

 
Figure 74 - Nadir Total Vertical Uncertainty breakdown by contribution source for the EM2040.  The real time uncertainty from 

the echo sounder is small and included in the “Other” portion of the plot. 

 
Figure 75 – Outer beam Total Vertical Uncertainty breakdown by contribution source for the EM2040.  The contribution from the 

echo sounder real time uncertainty is small relative to other factors. 
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Both Figure 74 and Figure 75 demonstrates that the EM2040 real time echo sounder uncertainty is not a 
major contributor to the total uncertainty and that the Caris HIPS configuration can be expected to meet 
IHO Order 1a specifications for uncertainty. 

7.4 Difference Surface 
The object detection lines from the vicinity of the wreck of the Bow Mariner were used to compare the 
fully integrated EM710 and EM2040 survey depths against previous data collected by NOAA Ship 
Thomas Jefferson during survey F00585.  All Thomas Jefferson acceptance survey data was collected to 
the ellipsoid, so an offset between ITRF 2008 and mean lower low water of -38.6 meters at the Bow 
Mariner location was computed using VDatum.  This offset was used to shift data to the same datum as 
the previous Thomas Jefferson survey.  The difference surface statistics between the previous Reson 
7125 and the new EM710 and EM2040 are described in Table 6.  Also included in this table are 
difference surface statistics between Thomas Jefferson’s EM2040 and survey H11504 by David Evans 
and Associates, which happened to cover some preliminary data collected with the new EM2040 before 
the acceptance cruise.  Patch test values were applied in post processing for these data, and the sound 
speed cast was adjusted to account for the faulty sensor present during preliminary testing (see 4.2.3). 

Table 6 - Difference surface statistics as computed within Caris HIPS. 

Location and System Mean Offset (m) Standard Deviation (m) 
Bow Mariner – EM710 -0.3 0.2 
Bow Mariner – EM2040 -0.2 0.1 
Chesapeake Bay – EM2040 0.2 0.1 

 

While there appears to be a consistent bias at the Bow Mariner site compared to the previous Reson 
7125 survey data, there is good agreement between the Thomas Jefferson EM710 and the EM2040.  
When considering this agreement with the opposing offset in the difference between previous survey 
coverage and Thomas Jefferson’s EM2040 at the two different locations, the bias may not be due to an 
offset internal to the survey system but in realizing the vertical datum.  The uncertainty in realizing the 
vertical datum (VDatum and the MarineStar Service) is approximately 0.14 meters at two standard 
deviations.  Since the mean uncertainty for the F00585 and H11504 surveys were 0.55 meters and 0.41 
meters respectively (both vertically referenced through tide zoning), Thomas Jefferson appears to be 
configured to produce properly vertically referenced soundings with the new survey system.  

8 Concluding Summary 
Two new Kongsberg multibeam echo sounders have been added to the NOAA Hydrographic fleet aboard 
NOAA Ship Thomas Jefferson.  While the EM710 and EM2040 appear to be functioning as specified and 
are integrated with the supporting sensors correctly, two residual problems remain.   

The primary problem is a leeward bathymetric artifact effecting both the EM2040 and EM710.  While an 
initial step to remedy this problem has been taken by removing the line guard in front of the transducer 
mount, further testing is required to evaluate if the problem is resolved.  If the problem is not resolved 
further steps will need to be taken to better characterize the source of the problem and engineer a fix. 
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The second problem is an artifact with the EM2040 200 kHz mode.  Kongsberg recommendations to 
resolve this problem have already been implemented and testing is required to understand if the issue 
persists. 

Thomas Jefferson has a workflow that will provide both ellipsoid and water level derived results in Caris 
HIPS.  While this workflow unfortunately does not take advantage of the real time GPS height and ray 
traced bathymetry, it does meet the requirements of the ship despite being more cumbersome. 

The EM2040 Min Depth detection mode was compared to the Normal detection mode and found to 
improve the recognition of features that reflect man made construction.  While this mode is useful for 
developments, it should not be used for general bathymetry to avoid collecting data on fish schools. 
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TJ Static Draft 
G. Rice, E. Younkin 
Hydrographic Systems and Technology Branch 
2016-10-12 

Introduction 
With her very large fuel capacity, Thomas Jefferson’s operational draft varies considerably over the 
course of a survey season.  The draft of the reference point has historically been measured with a 
flexible water level sight tube.  However, procedures for measuring and recording this value have not 
been well defined.  To improve this process, a Sutron bubbler water level gauge was installed in 2014 to 
replace manual sight tube readings.  In this report, we discuss the Sutron water level gauge and analyze 
data taken through gauge readings, draft mark readings and ellipsoidally referenced tide station data.  
We find all three systems of measurement to be acceptable, but the Sutron gauge provides the easiest 
and most precise measurement of static draft. 

Manual Sutron and draft mark observations were made at 1140 and 1300 UTC and POS M/V data was 
recorded between these times.  Through the use of the Autopoll software, one-minute interval Sutron 
data was also logged to a local computer.  The Marinestar corrected POS MV data was processed in 
POSPac in forwards/backwards processing mode without the inclusion of base station data in order to 
generate an SBET.  This SBET was used in the ellipsoidally referenced static draft script. 

In this report, draft is defined as the distance from the reference point to the water surface with the 
positive direction down; when the reference point is above the water surface, as it typically is with 
Jefferson in all but her most heavily laden conditions, the draft will be a positive number.  This is 
consistent with the sign conventions in both Caris and Kongsberg. 

Vessel Sensitivity to Loading 
By examining the ship stability tables, the weight of the survey launches, and typical fuel burns, we can 
calculate the vessel’s sensitivity to loading.  At her design draft, the stability book indicates 190.6 long 
tons per foot submergence, or 14,000 lbs/cm submergence.  This means that an additional 14,000 lbs of 
deck loading will cause the ship to sink into the water by 1 cm.  Conservatively estimating the full, laden 
weight of a launch at 18,000 lbs, the draft change from either deploying or recovering both launches is 
approximately 0.025 m.  The typical daily fuel burn at survey speed (approximately 1600 gallons per 
day), will result in a draft change of less than 0.01 m per day or less than 0.06 m per week.  Accordingly, 
we recommend updating the draft value in the HVF no more than once a week during survey 
operations.  

Sutron Installation and Configuration 
The Sutron bubbler water level gauge, similar to the NOAA field unit installed water level gauges, uses 
compressed gas to carry the static pressure at a submerged orifice to the pressure gauge in the 
instrument.  This configuration allows the pressure sensor to be both dry and also be balanced against 
the atmospheric pressure such that variations in atmospheric pressure can be neglected in the 
determination of the water level head pressure.  A photo of the sea-valve and orifice configuration is 
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shown in Figure 1.  With the vent valve open, the measured pressure is at the level of the orifice indicted 
by the arrow.  This offset was measured by IMTEC in 2016 as 3.908 meters with respect to the IMU 
reference point [1].  With the vent valve closed, the effective orifice is the penetration in the shell 
plating.  The offset to the shell plating was not accurately measured during the installation.  In normal 
operations, the vent valve should be left open.   

 

 
Figure 1: Bubbler gauge orifice and vent line.  Vent valve has yellow handle and should be OPEN.  Arrow indicated surveyed 
position of orifice and the location of the measured draft. 

In general, conversion of a pressure measurement to a depth requires knowledge of the density of the 
water and the local gravitational attraction.  The general equation of the height of the reference point 
above the water level is given below.  This is the value (with correct sign) used in the ‘waterline’ section 
of the Caris HVF and in Kongsberg SIS.  

orificeZ
g

psiPascalPSIwl
*

/7.6894
       (1) 

where wl is the height of the reference point above the waterline, ρ is water density in kilograms/ 
meter3, g is the acceleration due to gravity, and orificeZ is the surveyed distance from the reference 
point to the bubbler orifice.  The gravitational acceleration, 9.79819 m/s2, was calculated from the 
WGS84 Gravity Model for latitude 36.  For these small depths, the effect of the variability of gravity is 
negligible, accounting for an effective draft error of less than 0.01 m for latitude changes between 0 and 
60 degrees.  The density effect is more significant, with a variation from fresh to salt water yielding a 
difference of approximately 0.08 m for this system.  Using typical sea-surface water density of 1024 
kg/m3, the formula for the height of the reference point above the water line is given by:  

908.3I)0.68718(PSwl          (2)  
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These figures have been entered into the custom fields of the bubbler gauge (station setup/ accubar 
setup/ accubar settings/ user slope and user offset) such that the output value is the meters of the 
reference point above the waterline (note that when the ship is fully laden, the reference point may be 
below the water line and this number will then be negative).  

On April 17, 2015 (Dn107) a series of six water level measurements were made from the IMU to the 
level in a sight tube.  A laser was set on the top of the IMU and a ruler used to measure the distance 
from the top of the IMU to the water level in the sight tube.  The reading was corrected for the height of 
the laser.  The water level was 0.285 ± 0.004 meters relative to the reference point.  That afternoon, a 
CTD cast measured a density of 1012 kg/m3 in the brackish waters of the Elizabeth River.  Using this 
density, the observed pressure of 5.182 psi on the bubbler gauge, and equation (2) above, the bubbler 
derived waterline height is 0.305 meters, yielding an error of 0.02 m.  The source of this error is 
unknown, but is within tolerance for hydrographic survey work. 

Unless extended survey operations are planned for fresh waters (e.g. the Great Lakes), we recommend 
the standard density of 1024 kg/m3 be used for the calculation of waterline and the custom offsets 
retained as entered.  In brackish waters, the reported draft variation with density may be significant 
enough to consider for precise calibration work, though can likely be neglected for routine survey work.  
In the case were additional precision is required, we recommend calculating the waterline from the 
observed pressure and observed density using equation (1) to derive the height.  

Sutron Results 
Readings were taken from the Sutron at the beginning and end of observations at 0.385 meters and 
0.351 meters respectively.  The readings were also recorded via AutoPoll every minute into CSV files and 
displayed in Figure 2.  Again, these readings are the water level relative to the IMU as the bubble gauge 
offset from the IMU, 3.908 meters, was entered into the Sutron.  The mean of this time series is 0.37 
meters with 0.02 at two standard deviations. 

 
Figure 2 - The Sutron time series. 
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There is a clear trend in the Sutron data.  When an extended time series is plotted it appears that the 
static draft test was conducted during an inopportune time as displayed in Figure 3.  After discussing this 
anomaly with the ship, we learned that ballast was taken on at approximately 1100 UTC to achieve an 
additional few inches of draft astern.  We can see that a change of about 3.5cm was seen in the Sutron 
derived waterline value.   Using the previously mentioned 14,000 lbs/cm loading estimate, we can say 
that about 49,000 lbs or about 21.71 cubic meters of sea water was taken on during this period. 

 
Figure 3 – The Sutron time series from 2016-10-12 for a period before and after the static draft test.  

Draft Mark Results 
The transom and bow (port side) draft marks were observed from the wharf at the times described.  The 
draft did not change at an observable amount over this time, with the transom reading 13.9 feet and the 
bow (port side) reading 13.8 feet.  This finding, along with our internal understanding of the accuracy of 
draft mark readings, led to our assumed two standard deviation of 0.07 cm.  A weighted average was 
used to estimate the draft at the horizontal location of the IMU, which is closer to the bow.  This 
average, 13.83 feet, was then converted to meters and referenced to the IMU using an IMU to keel 
offset derived from the raw survey values from the ship offset survey conducted in August of 2016 [1].  
This offset was derived by averaging the keel vertical offset observations after the values were 
referenced to the IMU, with a result of 4.56 meters.  The final result, 0.34 meters, with this derivation 
from the draft marks is shown in Table 1.  
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Table 1 - Draft of the reference point from draft mark readings 

 

Ellipsoid Referenced Static Draft Results 
A POS MV file was recorded during the time period described and processed in POSPac using 
forwards/backwards processing without the inclusion of any base station data.  While some attempt 
was made to understand the waterline offset from the AutoQC tool in Pydro, eventually the ERSD script, 
also in Pydro, was used instead.  This approach results in a poorer tide correction since the phase and 
amplitude at the Atlantic Marine Operations Center from the local tide gauges is not taken into account.  
The script was run twice, once for the Money Point tide gauge, 8639348, and again for the Sewell’s Point 
tide gauge, 8639610. 

The ERSD script references the water levels to the ellipsoid using a provided offset from the water level 
data to the ellipsoid.  The water levels are then subtracted from the ellipsoid height of the ship, with the 
resulting value being the reference point draft over time.  These values are then averaged for a final 
estimate.  More information on the ERSD script can be found in [2]. 

The Money Point gauge reference resulted in a mean draft of 0.43 meters with two standard deviations 
being 0.07 meters as reported by the script in Figure 4.  The offset from mean lower low water to 
WGS84 provided by VDatum for the Money Point gauge was -39.0014 meters. 
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Figure 4 - SBET values relative to the ellipsoid referenced water levels from Money Point over the time period. 

The Sewell’s Point gauge reference resulted in a mean draft of 0.32 meters with two standard deviations 
being 0.08 meters as reported by the script in Figure 5.  The offset from mean lower low water to 
WGS84 provided by VDatum for the Sewell’s Point gauge was -38.7367 meters. 

 
Figure 5 - SBET values relative to the ellipsoid referenced water levels from Sewell’s Point over the time period. 
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Conclusion 
The draft of the reference point from the different approaches is summarized in Table 2. 

Table 2 – A summary of the static draft estimates. 

Source Result (Meters) 2 Standard Deviations (Meters) 
Draft Readings 0.34 0.07 

Sutron 0.37 0.02 
ERSD – Money Point 0.43 0.07 
ERSD – Sewell’s Point 0.32 0.08 

 

No final value is derived as the static water level changes with loading conditions.  Instead this series of 
tests confirms that each method arrives at a statistically equivalent value, and any of them could be 
used.  That being said, only the ERSD and Sutron method are precise enough to even see the 3.5cm 
change in draft during the testing period.  This is to be expected, as that frequency and precision of both 
POS MV and tide gauge measurements far surpasses the draft readings and that change was well within 
the variability of the draft reading measurement.  For its simplicity and precision, the Sutron gauge is the 
recommended method for estimating the ship’s static water level.  The Sutron should only be used 
when the ship is dead in the water as water flowing over the hull will affect the measurement. 

References 
[1] “NOAA Thomas Jefferson (S 222) Sensor Alignment & Orthogonal Coordinate Survey July-August 
2016, Rev 1,” The IMEC Group, Ltd, 2016 

[2] G. Rice, “Estimating Vessel Static Waterline Using Vessel Ellipsoid Height,” NOAA Office of Coast 
Survey, Silver Spring, MD, Tech Rep. 2011 
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NOAA Ship Thomas Jefferson CARIS HIPS 9.1 Post Processing Workflow 
for the EM2040 
HSTB, December 7, 2016 

Purpose 
NOAA Ship Thomas Jefferson’s survey system is configured differently than other Kongsberg systems in 
the NOAA hydrographic fleet.  Most notably, the primary reference point for the survey system is placed 
at the IMU rather than the multibeam transmit transducer because Thomas Jefferson has two 
multibeam systems; one POS MV configuration works for both.  Also of note, Thomas Jefferson has a 
MarineStar license and can thereby use the ellipsoid height stored in the Kongsberg data directly 
without the need for POSPac post processing.   

Because of how the reference point- transmitter lever arm is accounted for in Caris, there is no one HVF 
and processing configuration that can accommodate the various possible processing paths (e.g. using 
real-time Marinestar height and SIS raytracing to convert and merge in Caris without sound velocity 
correction (SVC), applying delayed heave and a new sound speed profile in Caris and using a tide 
corrector, etc.).  Each of these processing paths can be accommodated, but many require different HVF 
configurations and processing parameters.  Please contact HSTB for additional details if interested. 

The recommended workflow options below have been formulated and tested by HSTB.  While the 
required steps making up each method may be less efficient than possible for a given approach, this 
affords the most flexibility for data processing under one HVF.  This HVF is named 
S222_EM2040_HSTB.hvf. 

The methods require application of the POS M/V TrueHeave (delayed heave) data and requires 
computing the SVC in CARIS HIPS; the latter is mandatory regardless of whether new sound speed 
information or calculations beyond that used in Kongsberg SIS data acquisition are available or 
desired.  Specifically, these steps are required for both the real-time ellipsoid-referenced survey (ERS) 
processing method and the traditional water levels processing method, as detailed below. 

Method 
The two methods are as follows: 

1)  ERS  
a. Convert MBES data  Load Delayed Heave  Sound Velocity Correct  Compute GPS 

Tides  Merge with GPS Tides  TPU 
 

2) Traditional Water Levels  
a. Convert MBES data  Load Delayed Heave  Load Tides  Sound Velocity Correct  

Merge  TPU 
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Procedure 
Conversion (both methods, 1 and 2) 
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Data sources are set to “Auto” in the following dialogues because CARIS conversion algorithms are 
capable of reading the .all file (and other file types; ie: hsx) and determining data source. 
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Import Delayed Heave (both methods, 1 and 2) 
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While a new sound speed profile does not need to be added in this step, the SVC step is required for 
these workflows.  By leaving the “Load new SVP file” box unchecked, CARIS will use the SV profiles 
embedded in the raw data per the .all file.  Apply Delayed Heave is selected so that lever arm 
corrections are performed accurately.  If Delayed Heave is not selected in this step, then a heave artifact 
will be introduced in the processed data. 
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GPS Tides is a method for computing the ellipsoid height of the vessel such that the bathymetry can be 
referenced to the ellipsoid.  SVC’d depths are compensated for motion and are relative to the static water 
level.  Because the converted vessel GPS Height (Kongsberg ,all EM Height) includes the water line 
offset and motion, in Compute GPS Tide we answer: False to Water Line, but apply=True to both the 
Dynamic Draft (to match the HVF) and the Dynamic Heave (Delayed Heave).  The following list 
summarizes the options accounting required in Compute GPS Tides for the Thomas Jefferson EM2040. 
-Smooth GPS height is not selected because we want to use the observed GPS Height. 
- Antenna offset is not selected because offsets from GPS antennas to the IMU accounted for in POS M/V 
-Dynamic Heave is applied in order to remove heave from the observed GPS Height, smoothing the time 
series the same way that accounting for heave smooths the bathymetry.  
-SIS is not accounting for lever arm offsets to the transducer from IMU with the GPS height, so the GPS 
Height is at the IMU as is Delayed Heave in the POS M/V file.  Thus MRU Remote Heave is not selected 
because our RP is the IMU; moment arms are identically zero. 
-Dynamic Draft (DD) is selected for congruence with HVF; DD is applied to the bathymetry per the HVF, 
so the GPS Height must be compensated to match. 
-The dynamic GPS Height values in the .all file (EM Height, per conversion) are offset from the IMU by 
the water line as defined in SIS.  Waterline is not applied because the SVC’d depths account for the 
waterline, per introductory paragraph in this section. 
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Merge and Compute TPU - Method 1 (ERS) 
Calculates the final position for soundings based on observed depths and applied corrections in post-
processing.  Select GPS Tides because this is an ERS processing method, and Delayed Heave as needed to 
match our application of the same in during our mandatory SVC, described above. 
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TPU for the vertical datum when surveying to the ellipsoid is a variance summation of the uncertainties 
associated with (1) MarineStar-aided POS MV height and (2) the datum separation (SEP) model.  The 
MarineStar uncertainty is placed in the Tide / Measured section of the TPU dialog as 0.11 meters.  The 
SEPuncertainty is placed in the Tide / Zoning section of the TPU dialog and is survey area-specific as 
provided in Project Instructions (e.g., for OPR-G329-TJ-16/17, VDatum SEP StdDev=0.148m).  Sonar 
uncertainty is per the converted Realtime Kongsberg metrics from the .all.  All other uncertainty sources 
are set to zeros via the HVF; see the Method 2 – Traditional Water Levels Compute TPU section for more 
information regarding this. 
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Load Tide, Merge and Compute TPU - Method 2 (Traditional Water Level Corrections) 

 

 

 

Normal practice in the traditional water level method is to enter the uncertainty values attributed to 
vessel speed (0.03m), loading (0.06m), draft (0.03m), and delta draft (0.05m) in the HVF TPU StdDev, for 
Compute TPU Uncertainty Source = Vessel look-up.  Our workflow sets them to zero in the HVF to 
account for our preference for one HVF for both non-ERS and ERS processing.  For the Method 2 
(Traditional Water Levels) we instead account for the aforementioned components as a single variance 
summation (root sum square; RSS=0.09m) and place that in the “Tide / Measured” slot.  The actual 
(total) tide error component as provided in section 1.3.3 of the Project Instructions is placed in the Tide 
/ Measured value (e.g., for OPR-G329-TJ-16/17, ZDF Tides StdDev = 0.10m).  For TCARI-based projects, 
an average uncertainty value will be provided in the PI as well (e.g., OPR-E350-TJ-16, TCARI mean StdDev 
= 0.07m; OPR-D302-TJ-16, TCARI mean StdDev = 0.22m). 
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Vessel:

Date: 10/13/2016 Dn: 287

Personnel:

PCS Serial # 6497

IP Address:

POS controller Version (Use Menu Help > About) version 8.46

POS Version (Use Menu View > Statistics) MV-320 version 5
GPS Receivers

Primary Receiver
Secondary Receiver

Location: D M S
Approximate Position: Lat 37 33 38.5

Lon 76 7 34.9
DGPS Beacon Station:
Frequency: n/a

Satellite Constellation (Use View> GPS Data)
Primary GPS (Port Antenna)

HDOP: 0.844
VDOP: 1.247

Sattelites in Use: 10

PDOP 1.880 (Use View> GAMS Solution)

POS/MV Calibration Report
Field Unit: Thomas Jefferson

SYSTEM INFORMATION
S222

Ligon

129.100.1.231

BD982 SN5409086558
n/a

CALIBRATION AREA
Chesapeake Bay

Marinestar



Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration Baseline Vector
n/a Two Antenna Separation (m) 0.024 X Component (m)
0.50 Heading Calibration Threshold 2.204 YComponent (m)

0 Heading Correction -0.001 Z Component (m)

Calibration Procedure:

Start time: 1139
End time: 1145
Heading accuracy achieved for calibration: 0.018

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values Baseline Vector
n/a Two Antenna Separation (m) 0.019 X Component (m)

0.500 Heading Calibration Threshold 2.208 YComponent (m)
0 Heading Correction -0.009 Z Component (m)

Baseline Vector
x ****POST PROCESSED VALUES 0.019 X Component (m)
x ARE USED IN POS VIEW SETUP 2.208 YComponent (m)

-0.009 Z Component (m)

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name:

POS/MV CONFIGURATION

POS/MV CALIBRATION

(Refer to POS MV V3 Installation and Operation Guide, 4-25)

GAMS Status Online?
Save Settings?

S222_Pos_Config_13October2016.nvm



The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

z-axis to align one frame with the other.

once-rotated y-axis to align one frame with the other.

twice-rotated x-axis to align one frame with the other.

GENERAL GUIDANCE

SETTINGS (insert screen grabs)
Input/Output Ports  (Use Settings > Input/Output Ports)

NOTE: 



Heave Filter  (Use Settings > Heave) Events  (Use Settings > Events)

All other events are the same as event 2

Time Sync  (Use Settings > Time Sync)

Does not exist on the POS/MV Version 5
Installation  (Use Settings > Installation)



Tags, Multipath and Auto Start  (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting  (Use Settings > Installation > Sensor Mounting)



GPS  Receiver Configuration   (Use Settings> Installation> GPS Receiver Configuration)

User Parameter Accuracy  (Use Settings > Installation > User Accuracy)

Frame Control  (Use Tools > Config)

Does not exist on the POS/MV Version 5

Primary GPS  Receiver

Secondary GPS Receiver
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Conductivity (S/m)

16-Dec-14 0.9998616
13-Jan-16 1.0000000

f = Instrument Output (kHz)
t = temperature (°C);    p = pressure (decibars); δ = CTcor; ε = CPcor;
Conductivity (S/m) = (g + h * f2+ i * f3 + j * f4) /10 (1 + δ * t + ε * p)
Residual (Siemens/meter) = instrument conductivity - bath conductivity

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0285
CALIBRATION DATE: 13-Jan-16

SBE 19 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g =  -4.07424315e+000
h =   4.86097982e-001
i =   1.16276806e-003
j =  -1.95838076e-005

CPcor = -9.5700e-008 (nominal)
CTcor =  3.2500e-006 (nominal)

BATH TEMP
(° C)

BATH SAL
(PSU)

BATH COND
(S/m)

INSTRUMENT
OUTPUT (kHz)

INSTRUMENT
COND (S/m)

RESIDUAL
(S/m)

22.0000
1.0000
4.5000
15.0000
18.5000
24.0000
29.0000
32.5000

0.0000
34.6096
34.5901
34.5484
34.5398
34.5304
34.5256
34.5228

0.00000
2.95997
3.26548
4.24221
4.58563
5.14078
5.66004
6.03057

2.88563
8.25324
8.61696
9.68699
10.03560
10.57451
11.05448
11.38446

0.00000
2.95995
3.26550
4.24225
4.58561
5.14073
5.66006
6.03072

0.00000
-0.00003
0.00002
0.00004
-0.00002
-0.00004
0.00002
0.00015

Date, Slope Correction

PPOST CRUISE
CALIBRATION
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Pressure (PSIA)

04-Jan-16     0.00

n = instrument output (counts)
Straight Line Fit:     Pressure (PSIA) = M * n + B
Quadratic Fit:           Pressure (PSIA) = PA0 + PA1 * n + PA2 * n2

Residual (%FSR) = (computed pressure - true pressure) * 100 / Full Scale Range

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0285
CALIBRATION DATE: 04-Jan-16

SBE 19 PRESSURE CALIBRATION DATA
FSR: 5000 psia S/N 86209976 TCV: 

QUADRATIC COEFFICIENTS: STRAIGHT LINE FIT:
PA0 =    2.491043e+003
PA1 =   -6.502022e-001
PA2 =   -1.851852e-008

M = -6.502105e-001
B =  2.490932e+003

PRESSURE
(PSIA)

INSTRUMENT
OUTPUT (counts)

COMPUTED
PRESSURE (PSIA)

RESIDUAL
(%FSR)

LINEAR
FIT (PSIA)

LINEAR
RESIDUAL (%FSR)

14.46
1011.26
2008.28
3005.28
4002.29
4999.32
4002.25
3004.78
2008.25
1011.30
14.46

3807.9
2276.0
744.0

-791.1
-2324.4
-3857.4
-2325.0
-791.9
743.4

2275.3
3808.7

14.87
1011.09
2007.28
3005.41
4002.27
4998.86
4002.66
3005.93
2007.67
1011.54

14.35

0.01
-0.00
-0.02
0.00
-0.00
-0.01
0.01
0.02
-0.01
0.00
-0.00

15.00
1011.05
2007.18
3005.31
4002.28
4999.05
4002.67
3005.83
2007.57
1011.51

14.48

0.01
-0.00
-0.02
0.00
-0.00
-0.01
0.01
0.02
-0.01
0.00
0.00

Date, Offset (%FSR)
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Temperature (Degrees C)

16-Dec-14   -0.86
13-Jan-16   -0.00

f = Instrument Output (Hz)
Temperature ITS-90 (°C) = 1/{g + h[ln(f0 / f )] + i[ln2(f0 / f)] + j[ln3(f0 / f)]} - 273.15
Residual (°C) = instrument temperature - bath temperature

Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0285
CALIBRATION DATE: 13-Jan-16

SBE 19 TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

COEFFICIENTS:
g =  4.12531391e-003
h =  5.76172682e-004
i = -3.65969797e-008
j = -2.84357970e-006
f0 =  1000.0

BATH TEMP
(° C)

INSTRUMENT
OUTPUT (Hz)

INST TEMP
(° C)

RESIDUAL
(° C)

    1.0000
    4.5000
   15.0000
   18.5000
   24.0000
   29.0000
   32.5000

  2297.536
  2490.712
  3139.079
  3379.526
  3783.254
  4178.845
  4472.438

    0.9996
    4.5007
   14.9994
   18.4999
   24.0002
   29.0006
   32.4996

  -0.00040
   0.00072
  -0.00058
  -0.00010
   0.00020
   0.00060
  -0.00045

Date, Offset (mdeg C)

PPOST CRUISE
CALIBRATION




